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In This Guide ...

In This Guide ...

This guide describes how to install the initial ChemStation software for LC 
or CE instruments, how to add further instrument modules, how to 
configure your analytical system, and how to verify that the installation 
and configuration are complete and operational.

1 Introduction

This chapter provides an introduction into the ChemStation software and 
summarizes requirements for hardware and software. 

2 Installation Preparation

This chapter summarizes procedures to prepare for a successful 
installation of Agilent ChemStation. 

3 Installing the Agilent ChemStation

This Chapter contains the detailed installation procedures to install the 
Agilent ChemStation, add instruments, upgrade or uninstall the software.

4 Configuring the Instruments

This chapter explains how to use the Configuration Editor to configure 
your instruments to work with the Agilent ChemStation.

5 Validating and Starting the Agilent ChemStation

This chapter explains how to use the Agilent ChemStation Installation 
Qualification utility to validate the proper installation and operation 
performance of the Agilent ChemStation on your PC. It also explains how 
to begin using the Agilent ChemStation once the installation has been 
validated.

6 Troubleshooting

This chapter summarizes helpful hints for troubleshooting potential 
problems you might see during the installation process.
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7 Upgrade History - Previous Revision A/B ChemStations

This Chapter gives information on the Upgrade history of ChemStation 
revisions

8 Additional Resources

 This chapter summarizes additional resources for ChemStation Users
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Agilent ChemStation Product Structure

The Agilent ChemStation for GC, LC, LC/MS, CE, and A/D has been 
designed as a series of software modules for instrument control, data 
acquisition, data analysis, and reporting. Technique- specific single 
instrument modules provide control capabilities for a given separation 
technique, e.g. for one Gas or Liquid Chromatograph. A single instrument 
configuration may be expanded by adding an additional instrument control 
module. With this approach, one Agilent ChemStation is capable of 
controlling more than one analytical system, e.g. two chromatographs of 
the same or different separation techniques.

For CE/MS and LC/MS no additional instruments are supported on the PC 
system. For CE additional CE, LC or GC instruments are supported only 
as co- existing instruments on the same PC, but co- execution is not 
supported.

Please note the memory requirements for every additional instrument 
module (see “Minimum PC Requirements” on page 10).

Figure 1 Agilent ChemStation Module Architecture

Additional Data Evaluation Modules

The acquired data is typically two- dimensional (“2D”), i.e. by measuring 
detector response over time. Spectroscopic detectors can deliver 
three- dimensional (“3D”) data, by additionally measuring detector 
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response over a third axis (e.g. wavelength or mass range). The optional 
“Spectral Evaluation Module” permits analysis and reporting of this “3D” 
data and is included with the CE/MS modules, and optional for an LC 
module.

The Agilent ChemStore Database Module, a results storage and 
organization module, may be added to all separation techniques.

The Agilent ChemStation is capable of controlling up to four instruments. 
The number of allowed modules per instrument is depending on the used 
communication module. For configuration limitations please refer to 
Table 2 on page 14. For CE/MS and LC/MS no additional instruments are 
supported on the PC system. For CE additional CE, LC, or GC instruments 
are supported only as co- existing instruments on the same PC, but 
co- execution is not supported.

Please note the memory requirements for each additional data evaluation 
module. For further details on supported configurations and their PC 
requirements, see “Minimum PC Requirements” on page 10.

Figure 2 A Combination of Modules
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Hardware Requirements

Minimum PC Requirements

Minimum hardware requirements for your Agilent Technologies 
ChemStation software (version B.04.02 SP1) are:

• A personal computer with an Intel Pentium IV processor (1.5 GHz for 
Windows XP, 3.4 Ghz single core for Windows Vista)

• 1280 x 1024 Super VGA resolution, 17 inch display, 16k colors or better 
(recommended: 19 inch, resolution 1440 x 900)

• 40 GB hard disk (with 600 MB free disk space) for Windows XP, 160 
GB hard disk for Windows Vista

• DVD- ROM drive

• Windows XP: 512 MB RAM (recommended: 1 GB); Windows Vista: 1 GB 
RAM (recommended: 2 GB) 

• MS Windows compatible pointing device

• LAN = Ethernet IEEE 802.3 Industry Standard 10/100 Base T

• LAN Cabling between the hub and LAN boards, category 4 or greater 
UTP with RJ- 45 connections

• Maximum supported cable distance = 100 meters

• Operating system compatible printer: 

• For the English system a printer using PCL 5c, 5e, 5e, 5.02 or 6

• For Japanese system use Canon LBP- 430, 450, 470, 1310, or 3410

• for the Chinese System a printer using PCL 6

• Either a Microsoft Windows XP Professional (Service Pack 3) or 
Microsoft Windows Vista Business (Service Pack 2) operating 
environment 

• TCP/IP protocol support installed, if you are using LAN 
communications
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• If you are using GPIB communication: The 82350 (A or B model) GBIB 
Board or 82357 (A or B model) USB- GPIB interface, depend on suitable 
personal computer, and Agilent IO Libraries Suite 15.0. Refer to the 
Manuals\Installation folder of the ChemStation DVD for IO Libraries Suite 
installation instructions.

All PC hardware and peripherals must be listed in the Microsoft Hardware 
Compatibility List (HCL) which is available from the Microsoft home page 
on the World Wide Web (http://www.microsoft.com). If your PC hardware 
is not listed in the HCL, the system may not work correctly with the 
Agilent ChemStation software.

Non-HP Computers 

The Agilent ChemStation is designed to successfully run on a wide range 
of compatible personal computers equipped with accessories and 
peripherals that adhere to the programming standards for the Intel PC 
platform and Microsoft Windows operating systems. 

However, Agilent has tested the Agilent ChemStation software mainly on 
Hewlett- Packard/Compaq equipment. All configuration information listed 
in this manual applies to Hewlett- Packard/Compaq Kayak, Vectra and EVO 
computers and may not be optimized for other vendor’s PCs. The standard 
configuration of the GPIB interface, for instance, may conflict with the 
memory configuration of a non Hewlett- Packard computer. Additional 
accessory interface boards may cause conflicts of hardware related 
resources (I/O ports, interrupt settings, DMA channels). 

For a non Hewlett- Packard computer, use the setup utility program 
supplied by the manufacturer to configure your computer and check the 
documentation supplied with it and the accessories to eliminate resource 
conflicts in your PC’s setup, especially regarding the configuration of the 
GPIB interface.
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Printers for the Agilent ChemStation

The Agilent ChemStation is designed to work with printers that are 
compatible with the operating system. Printers may be attached to a local 
(preferably parallel) or networked port on the PC. Serial port printers are 
supported by the operating system but may exhibit speed performance 
limitations. Networked printers must be shared by a network server 
running a network protocol supported by the Microsoft operating system. 
We recommend printers that are capable of interpreting an escape code 

language (such as PCL) or page description language (such as PostScript®). 
Host- based printers (such as GDI or PPA printers) impose more printer 
processing tasks on the CPU and are not recommended for use with 
Agilent ChemStation online sessions. 

For best printing results with your Agilent ChemStation, use HP LaserJet 
printers. High performance HP DeskJet printers may also be used if the 
amount of printing required is low. Check the readme.txt files for 
information on recommended printer driver versions.

Agilent Technologies has not tested all printer and printer driver 
combinations that are supported in the Windows environment. Print 
performance and results may vary on other manufacturer’s printers and 
appropriate drivers. The printers listed in Table 1 on page 12 have been 
successfully tested at the time this handbook was printed.

Table 1 Successfully tested Printers

Printer Model Driver comment

HP LaserJet 4050 and HP LaserJet 4100 HP PCL 5e Driver or PCL 6

HP LaserJet 4200 HP PCL 5e Driver or PCL 6

HP LaserJet 4250 PCL 6 Driver

HP LaserJet P3005D PCL 6 Driver

HP Color LaserJet 2500TN (C9707A) PCL 6 Driver

OfficeJet Pro K550DTWN PCL 3 Driver

OfficeJet Pro K5400 PCL 3 Driver

HP LaserJet 2200D HP PS 5.02 or PCL 6 Driver

HP LaserJet 2300dn HP PS 5.02 or PCL 6 Driver
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Advanced Power Management (Not Supported with Analytical 
Hardware)

The BIOS and operating systems of many modern PCs support Advanced 
Power Management (APM). After a specified idle time, the BIOS switches 
the system to a stand- by mode by turning off the hard disk and other 
devices. This reduces the PC power consumption and the internal clock 
frequency to save energy.

The reduction in internal clock speed and hard disk slow down can render 
a PC incapable of handling the real- time requirements of instrument 
control and data acquisition. Typically, this results in overflows of the 
internal instrument buffers, or, in other words, loss of data. Agilent 
Technologies recommends that you switch off APM for systems running 
on- line operation of analytical hardware. 

HP LaserJet 2300D (Q2474A) HP PCL 5e Driver or PCL 6 Driver

HP LaserJet 2420D HP PCL 6 Driver

HP LaserJet P3005D PCL 6 Driver

Adobe Acrobat version 7.0, 8.0

Amyuni PDF Converter version 2.50

PDF-XChange version 4.0 
installed during ChemStation installation

Table 1 Successfully tested Printers

Printer Model Driver comment

NOTE Please note that this list is not comprehensive and does not include printers and printer 
drivers made available after the release of this handbook. If your printer is not listed here, it 
does not mean it will not work with the Agilent ChemStation, but it has simply not been 
tested.
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Number of Instruments Supported

A maximum number of 4 instruments can be configured on a single 
Agilent ChemStation PC. Each instrument can consist of several modules, 
like Agilent 1100/1200 LC modules. For specific configurations and 
software add- ons, the maximum number of instruments is listed in 
Table 2 on page 14.

There is also a limitation on the total number of instrument modules 
connected to the Agilent ChemStation. Up to a maximum number of 18 
modules per PC can be connected, depending on the exact module 
configuration and LAN connection point. These can be about 12 modules 
like pumps, detectors, injectors, etc. and approx. 6 CAN- slave modules like 
valves and UIB interfaces. A maximum of 4 detectors per instrument are 
supported, whereas only 2 of one kind can be used in the same 
instrument, for Variable Wavelength Detectors (VWD) up to 3. The 
maximum number of G1314C VWD SL Detectors, as well as G1315C or 
G1315D DAD Detectors is limited to two detectors per PC.

NOTE While acquiring data in three or four instrument configurations, interactive data 
reprocessing is not recommended.

Table 2 Maximum Number of Instruments

Description max. Number of 
instruments

ChemStore C/S Data Management Module 3

2 modules that can acquire on-line spectra, e.g. DAD or FLD 2

Agilent LC/MSD 1

NOTE Please contact your Agilent representative to check if your exact configuration is possible, 
especially when your configuration is above 12 modules.



Installing LC and CE ChemStation 15

Introduction 1
Operating System Requirements

Operating System Requirements

ChemStation Rev. B.04.02 SP1 is available in English, and as localized 
versions in Japanese and Chinese. Depending of your choice of 
ChemStation, you will need the corresponding Microsoft Windows XP 
Professional (Service Pack 3) or Microsoft Vista Business (Service Pack 1) 
operating system: 

• English Microsoft Windows XP Professional Service Pack 3 or

English Microsoft Vista Business Service Pack 2 (32 bit)

• Japanese Microsoft Windows XP Professional Service Pack 3 or

Japanese Microsoft Vista Business Service Pack 2 (32 bit)

• Chinese Microsoft Windows XP Professional Service Pack 3 or

Chinese Microsoft Vista Business Service Pack 2 (32 bit)

Windows XP Professional or Windows Vista Business are the only 
supported operating systems for the Agilent ChemStation data acquisition 
and analysis software.

For up- to- date information on supported operating systems please contact 
your local service and support center.

If you use a LAN to connect to the analytical instruments, the Microsoft 
TCP/IP protocol must be installed and configured.

NOTE Agilent cannot give a support statement for other non-english operating systems.

NOTE ChemStation Rev. B.04.02 SP1 is NOT supported on Windows 7.
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File Names and Naming Conventions

Detailed information regarding allowed characters used for file and 
directory names, as well as path length statements are documented in the 
Understanding your Agilent ChemStation manual, Chap. 1. The manual is 
delivered with the instruments and available as PDF file in the Support\
Manuals\Understanding and Concepts directory of the Agilent ChemStation 
DVD.
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Instrument Firmware Requirements

1100/1200 LC Instrument firmware requirements

The Agilent 1100/1200 series of LC modules have flash ROM memory. 
Firmware updates are distributed electronically. The latest firmware can 
be downloaded from the following Agilent Technologies website: 
http://www.chem.agilent.com/scripts/cag_firmware.asp. Starting with 
firmware A.06.0x/B.01.0x, a new firmware update tool is available and 
distributed along with the Agilent ChemStation Software DVD.

Table 3 LC 1100/1200 Series Instrument Firmware Requirements

LC Instrument Product No Firmware Revision

Samplers

Agilent 1100/1200 Automation Interface G2254A A.06.10 or newer

Agilent 1100 Autosampler G1313A A.06.10 or newer

Agilent 1100/1200 Thermo. Autosampler G1329A A.06.10 or newer

Agilent 1200 Thermo. Autosampler SL G1329B A.06.10 or newer

Agilent 1100 Micro Sampler G1389A A.06.10 or newer

Agilent 1100/1200 Preparative Autosampler G2260A A.06.10 or newer

Agilent 1100 Well Plate Autosampler G1367A A.06.16 or newer

Agilent 1200 High Performance Autosampler G1367B A.06.16 or newer

Agilent 1200 High Performance Autosampler SL G1367C A.06.16 or newer

Agilent 1200 High Performance Autosampler SL Plus G1367D A.06.16 or newer

Agilent 1100 Thermost. Well Plate Autosampler G1368A A.06.10 or newer

Agilent 1100/1200 Micro Well Plate Autosampler G1377A A.06.16 or newer

Agilent 1100/1200 Thermost. Micro Well Plate Autosampler G1378A A.06.10 or newer

Agilent 1100/1200 Dual Loop Autosampler PS G2258A A.06.16 or newer

Agilent 1290 Infinity High Performance Autosampler G4226A A.06.30 or newer
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Column Compartments

Agilent 1100/1200 Thermostatted Column Compartment G1316A A.06.10 or newer

Agilent 1200 Thermostatted Column Compartment SL G1316B A.06.10 or newer

Agilent 1290 Infinity Thermostatted Column Compartment G1316C A.06.30 or newer

Agilent 1100/1200 Chip Cube Interface G2240A A.06.11 or newer

Pumps

Agilent 1100/1200 Isocratic Pump G1310A A.06.10 or newer

Agilent 1100/1200 Quaternary Pump G1311A A.06.10 or newer

Agilent 1100/1200 Binary Pump G1312A A.06.10 or newer

Agilent 1200 Binary Pump SL G1312B A.06.11 or newer

Agilent 1290 Infinity Binary Pump G4220A B.06.30 or newer

Agilent 1100/1200 Capillary Pump G1376A A.06.11 or newer

Agilent 1100/1200 Preparative Pump G1361A A.06.11 or newer

Agilent 1100/1200 Nano Pump G2226A A.06.11 or newer

Detectors

Agilent 1100 DAD G1315A A.06.10 or newer

Agilent 1100/1200 DAD G1315B A.06.10 or newer

Agilent 1100/1200 DAD SL G1315C B.06.30 or newer1

Agilent 1200 DAD G1315D B.06.30 or newer2

Agilent 1290 Infinity DAD G4211A A.06.10 or newer

Agilent 1100 MWD G1365A A.06.10 or newer

Agilent 1100/1200 MWD G1365B A.06.10 or newer

Agilent 1100/1200 MWD SL G1365C B.06.30 or newer1

Table 3 LC 1100/1200 Series Instrument Firmware Requirements

LC Instrument Product No Firmware Revision
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Agilent 1200 MWD G1365D B.06.10 or newer2

Agilent 1100/1200 FLD G1321A A.06.11 or newer

Agilent 1100 VWD G1314A A.06.13 or newer

Agilent 1200 VWD G1314B A.06.13 or newer

Agilent 1200 VWD SL G1314C A.06.13 or newer

Agilent 1200 VWD G1314D B.06.25 or newer3

Agilent 1200 VWD SL Plus G1314E B.06.25 or newer3

Agilent 1100/1200 RID G1362A A.06.10 or newer

Agilent 1100/1200 UIB G1390A A.06.10 or newer

Fraction Collectors

Agilent 1100 Fraction Collector G1364A A.06.10 or newer

Agilent 1100/1200 Fraction Collector PS G1364B A.06.10 or newer

Agilent 1100/1200 Fraction Collector AS G1364C A.06.10 or newer

Agilent 1100/1200 Micro Fraction Collector G1364D A.06.10 or newer

Valves

2Pos/10Port Valve G1157A A.06.10 or newer

2Pos/6 Port Valve G1158A A.06.10 or newer

2Pos/6 Port Valve SL G1158B A.06.10 or newer

6Position Selection Valve G1159A A.06.10 or newer

12Pos/13 Port Selection Valve G1160A A.06.10 or newer

2Pos/6 Port Micro Valve G1162A A.06.10 or newer

2Pos/10 Port Micro Valve G1163A A.06.10 or newer

Agilent 1290 Infinity Flexible Cube G4227A C.06.30 or newer

Table 3 LC 1100/1200 Series Instrument Firmware Requirements

LC Instrument Product No Firmware Revision
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Others

Agilent 1100/1200 Degasser G1322A All Revisions

Agilent 1100 Micro Degasser G1379A All Revisions

Agilent 1200 Micro Degasser G1379B All Revisions

Agilent 1100/1200 Manual Injector G1328B All Revisions

Agilent 1100/1200 Thermostat f. Sampler/ Fraction 
Collectors

G1330B All Revisions

Agilent 1100 Local User Interface (A.02.03) G1323A A.05.xx4

Agilent 1100/1200 Local User Interface (B.03.22 and below) G1323B A.05.xx

Agilent 1100/1200 Local User Interface (B.04.02 and above) G1323B A.06.01/02/05/1x; 
B.01.02/06/1x; 
B.06.2x

Agilent 1100/1200 Control Module Instant Pilot G4208A B.02.09 or newer

Agilent 1200 SFC Fusion A5 G4301A use firmware 
included on CD 
shipping with the 
hardware

1 The Agilent G1315C DAD and G1365C MWD modules require minimum firmware B.01.02. This 
firmware is only compatible with firmware A.06.02 or higher. As soon as a G1315C/G1365C is used 
in an 1100/1200 stack, the whole stack needs to be compatible using firmware A.06.02 or higher.

2 The Agilent G1315D DAD and G1365D MWD modules require minimum firmware B.01.04. This 
firmware is only compatible with firmware A.06.02 or higher. As soon as a G1315D/G1365D is used 
in an 1100/1200 stack, the whole stack needs to be compatible using firmware A.06.02 or higher.

3 The Agilent G1314D and G1413E VWD modules require minimum firmware B.06.20. This firmware 
is only compatible with firmware A.06.1x or higher. As soon as a G1314D/E is used in an 
1100/1200 stack, the whole stack needs to be compatible using firmware A.06.1x or higher.

4 The Agilent 1100 local user interface G1323A is supported in combination with the following mod-
ules: G1310A, G1311A, G1312A pumps, G1313A ALS, G1314A VWD, G1315A DAD, G1316A TCC, 
G1321A FLD

Table 3 LC 1100/1200 Series Instrument Firmware Requirements

LC Instrument Product No Firmware Revision
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1120 Compact LC firmware requirements

The LC ChemStation software requires firmware B.06.2x for the 1120 
compact LC.

35900E A/D converter firmware requirements

Agilent 35900E A/D converter have flash ROM memory. The GC Firmware 
Update Utility is provided on the ChemStation DVD under the Support 
directory. Firmware updates are distributed electronically. The latest 
firmware can be downloaded from the following Agilent Technologies 
website: http://www.chem.agilent.com/scripts/cag_firmware.asp

CE Instrument Firmware Requirements 

The CE ChemStation software requires the following minimum firmware 
revisions in order to work with the devices shown in Table 4 on page 21.

A/D Converter Product Number Firmware Revision

35900E E.01.02

Table 4 CE Instrument Firmware Requirements 

CE Instrument Firmware Revision

G1601A

Built-in DAD Rev. 1.2 or higher

Mainframe Agilent CE G1601A Rev. 2.3 or higher

G7100 Rev. B.06.25 or higher
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This chapter summarizes procedures to prepare for a successful installation of 
Agilent ChemStation. 
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Before You Begin

Before installing your Agilent ChemStation software, configure your PC 
as follows:

1 Keep your PC disconnected from the Internet during the installation 
phase. (We recommend that you install the latest security fixes, as 
supported by Agilent, and install virus definitions before connecting to 
any network.)

2 Verify that your PC meets the minimum PC requirements (see 
“Minimum PC Requirements” on page 10.)

3 The Agilent ChemStation communicates through either a LAN or GPIB 
(General Purpose Interface Bus) communication interface. Set up the 
communication channel between the instrument and the PC as 
described in “LAN communication” on page 26 and “GPIB and 
USB- GPIB Communication” on page 39.

4 Set up your instrument communications as described in “Instrument 
Communication” on page 44.

5 Log on with Windows administrator privileges.

6 Set the Regional Options and Language Options in the Control Panel of 
your System to English (US). If you use another language, the following 
settings are mandatory:

• Decimal symbol = . (point)

• Digit grouping symbol = , (comma) 

• List separator = , (comma)

ChemStation will not start when a decimal separator other than . is 
used.

7 In your system's Control Panel in the Regional and Language Options at 
the Advanced tab set the language for non- Unicode programs to English 
(US)

8 Disable the advanced power management settings on your computer, 
such as system standby and system hibernation.
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NOTE For more details on optimizing operations using Windows XP or Windows Vista, please 
follow the instructions outlined in the document Configure and Maintain Your ChemStation 
Computer, which is available as a PDF file on the Agilent ChemStation DVD. That document 
describes required system settings for the best Agilent ChemStation performance.

NOTE If you are upgrading your Agilent ChemStation software, your system may require hardware 
or operating system changes before installing the new software.

Please read the document entitled Upgrade Preparation Guide for Agilent ChemStation 
B.04.02 SP1 for detailed instructions on how to prepare your PC for upgrading. The 
documentation is available as a printed document and also as a PDF file found in the 
Manuals directory of the Agilent ChemStation DVD.
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LAN communication

The Agilent ChemStation communication uses the TCP/IP protocol, which 
needs to be installed as a network protocol on your PC. 

The JetDirect and G1369A LAN cards used to connect an analytical 
instrument to a LAN require the boot strap protocol (BootP). Agilent 
supports only the Agilent Bootp Service, provided on the ChemStation 
DVD, for this use.

Version B.04.02 SP1 of the Agilent ChemStation software provides 
LAN- based instrument control and data acquisition for LAN- capable 
Agilent LCs and optional A/D controllers. You can easily control and 
monitor instruments by connecting them to a LAN on which the Agilent 
ChemStation PC resides. This allows the Agilent ChemStation PC to be 
located up to 100 meters from instruments it controls on an 
Agilent- supported standalone LAN, or anywhere in the world on a 
TCP/IP- based network supported by your network administrator.

About LAN 

Each Agilent ChemStation can support up to four instruments on the 
LAN. Each device on the LAN requires a unique IP address, a subnet 
mask, and a default gateway.

If installing on a site LAN, contact the site LAN administrator. If installing 
on an isolated LAN, Agilent recommends the following addresses: 

Device Address 

PC 10.1.1.100

LC and optional A/D Control Module 10.1.1.102 through 10.1.1.255

Subnet mask 255.255.255.0

Gateway 10.1.1.100
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Agilent ChemStation supports instruments and PCs with self- assigned, 
fixed addresses, or addresses assigned by the Agilent Bootp Service (see 
“Agilent Bootp Service” on page 29). DHCP is not supported by Agilent.

Using LAN Communication

If you connect your instrument using a standard TCP/IP protocol, it needs 
to be installed as a network protocol on your PC. The current 
configuration of the LAN Assembly or Jet Direct or G1369A LAN cards 
that are used to connect the analytical instrument to the LAN remains 
during the upgrade.

When upgrading from a GPIB control instrument to LAN connection, you 
must install the required LAN communication components and reconfigure 
your instrument. 

Customers using LAN communication or moving from GPIB to LAN 
connection have to use the Agilent BootP Service as communication 
component for ChemStation Rev. B.04.02 SP1. Customers currently using 
the CAG BootP Server need to remove this component. The Agilent BootP 
Service needs to be installed instead; the CAG BootP Server is no longer 
supported. The Agilent BootP Service Program can be found on the 
ChemStation DVD.

Installing LAN Communication

If you decide to connect your instrument using a standard LAN 
connection, you must ensure proper communication between the PC and 
the analytical instruments. The communication uses the TCP/IP protocol, 
which needs to be installed as a network protocol on your PC. For the 
configuration of the JetDirect card or G1369A LAN card that is used to 
connect the analytical instrument to the LAN, the boot strap protocol is 
used, which requires a BootP Service.
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The installation of the TCP/IP protocol on Windows XP or Windows Vista 
systems is outlined below. Windows XP or Windows Vista systems will 
typically come with TCP/IP pre- installed. Instructions are also included 
for the Agilent Bootp Service program required to configure TCP/IP 
parameters for your instrument.

1 From the Start menu in the Task Bar, select Start > Settings > Control Panel.

2 Open Network and Dial-up Connections, select Local Area Connection and use 
right mouse click to access the properties.

3 In the General tab, select the internet protocol TCP/IP and choose 
Properties.

4 Select Use the following IP address to ensure that the system does not use 
the DHCP address.

5 Ask your IT department for a valid IP addresses, gateway, subnet mask, 
DNS and WINS server, if your PC is connected to a site network. If you 
are setting up your own internal network for instrument communication 
and are not connected to any other network, you may use the example 
settings from Table 5 on page 28.

Gateway, DNS, and WINS IP addresses do not need to be configured in 
this case, as you do not connect to any other part of a network. 
Figure 3 on page 29 shows an example of the TCP/IP configuration on 
Windows XP.

Table 5 Example IP addresses

PC or instruments IP address Subnet mask

PC 1 10.1.1.100 255.255.255.0

LC instrument module (1100/1200) 10.1.1.101 255.255.255.0

optional 35900E A/D converter 10.1.1.102 255.255.255.0

NOTE You need one IP address per device. This means one for the PC, another one for the 
1100/1200 stack of modules (usually connected by the detector) and optionally a third one 
for the 35900E A/D converter.
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Figure 3 TCP/IP Configuration Screen

6 Select OK to finish the configuration.

Agilent Bootp Service 

Agilent Bootp Service provides central administration of IP addresses for 
Agilent instruments on a LAN. The service runs on the instrument LAN 
PC, which must be running TCP/IP network protocol and cannot run a 
DHCP server.

When an instrument is powered on, an Agilent JetDirect card in the 
instrument broadcasts a request for an IP address or Host Name and 
provides its hardware address as an identifier. The request may continue 

NOTE Use the IPCONFIG utility to verify the PC's TCP/IP settings by opening a command window 
and typing 
ipconfig /all
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for up to 5 minutes. The Agilent Bootp Service answers this request and 
passes a previously defined IP address and Host Name associated with the 
hardware address to the requesting instrument. 

When the instrument receives its IP address and Host Name, it stops 
broadcasting the request. It maintains the IP address as long as it is 
powered on. Powering down the instrument causes it to lose its IP 
address, so the Agilent Bootp Service must be started. Since the Agilent 
Bootp Service runs in the background, the instrument will receive its IP 
address on power- up.

Before installing and configuring the Agilent Bootp Service, you must 
know the IP addresses of the computer and instruments, the subnet 
mask, and the gateway (see “Installing LAN Communication” on 
page 27).

1 Log on as Administrator or other user with Administrator privileges.

2 Close all Windows programs.

3 Insert the Agilent ChemStation Software DVD in the drive. If the setup 
program starts automatically, click Cancel to stop it.

4 Open Windows Explorer.

5 Go to the Bootp directory on the Agilent ChemStation software DVD and 
double- click BootPPackage.msi.

6 The Welcome screen of the Agilent Bootp Service Setup Wizard appears. 
Click Next.

7 The End- User License Agreement screen appears. Read the terms, 
indicate acceptance and click Next.

8 Check destination folder for installation and confirm by clicking Next.

9 Click Install to begin the installation
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10 Files load; when finished, the Bootp Settings screen appears.

11 Check Do you want to log Bootp requests?

12 In the Default Settings part of the screen, enter the subnet mask and 
gateway.

13 Press Create Tab File.

14 Click OK. The BootP Service Setup Wizard screen indicates completion.

15 Press Finish and remove the DVD from the drive.

This completes installation of Agilent Bootp Service.

NOTE The Bootp Settings screen contains unconfigured default settings. These settings will be 
entered during the configuration procedure.

NOTE The Do you want to log Bootp request? box must be unchecked when finished configuring 
instruments or the logfile will quickly fill up disk space.

NOTE See your network administrator if you do not know the subnet mask and gateway.

The default subnet mask is 255.255.255.0. The default gateway is 10.1.1.100.
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Instrument configuration using the Agilent Bootp service

Assigning IP addresses to instruments using the Agilent Bootp service

Agilent Bootp Service maintains association between a unique 
identification code (MAC address) provided with the LAN card installed in 
a given instrument and the specific IP address assigned to that 
instrument. Therefore, you must define, or redefine this association 
whenever you add a new instrument, exchange an instrument (or its LAN 
card), or change the IP address assigned to an instrument.

Configuring instruments using the Agilent Bootp service 

1 Determine the MAC address of the LC with the JetDirect card installed 
using either:

• Agilent Bootp Service (see step 2 on page 32)

• A JetDirect card (see step 3 on page 33)

2 To use Agilent Bootp Service to determine the MAC address of the LC:

a Power cycle the LC.

b After the LC completes self- test, open the logfile of the BootP 
Service using Notepad. 

• The default location for the logfile is C:\Documents and Settings\All 
Users\Application Data\Agilent\BootP\LogFile. 

• The logfile will not be updated if it is open.

• Assign an address only to devices that cannot set their own 
address. See the instrument’s operating documentation for more 
information.

The contents will be similar to that shown below: 02/25/04 15:30:49 PM 
Status: Bootp Request received at outer most layer Status: Bootp Request received 
from hardware address: 0010835675AC Error: Hardware address not found in 
BootpTAB: 0010835675AC Status: Bootp Request finished processing at outer most 
layer

c Record the MAC address (0010835675AC) from screen, here called 
the hardware address.

d Close the logfile before turning on another instrument. 

e Skip to step 4 on page 33.
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3 To use a JetDirect card to determine the MAC address of the LC:

a Turn off the instrument.

b Remove the JetDirect card.

c Read the MAC address from the label and record it.

The MAC address is printed on a label on the noncomponent side of 
the JetDirect card. It is the number below the barcode and after the 
colon (:) and usually begins with the letters AD. 

d Reinstall the card.

e Turn on the LC.

4 Add the LC instrument to the network.

a Follow Start > Programs > Agilent Bootp Service and select 
EditBootPSettings. The BootP Settings screen appears.

b Uncheck Do you want to log BootP requests?

The Do you want to log BootP requests? box must be unchecked when 
finished configuring instruments or the logfile will quickly fill up 
disk space.

c Click Edit BootP Addresses.... The Edit Bootp Addresses screen appears.

d Click Add.... 

The Add Bootp Entry screen appears.
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Figure 4 Add BootP Entry screen

e Make these entries for the LC:

• MAC Address, as previously obtained and recorded

• Host Name

• IP Address 

• Comment, if desired

• Subnet Mask

• Gateway address (optional)

f Click OK.

g Leave Edit BootP Addresses by pressing Close.

h Exit BootP Settings by pressing OK and power cycle the LC.

If changing the IP address, it will be necessary to power cycle the 
instrument for the changes to take effect.



Installing LC and CE ChemStation 35

Installation Preparation 2
LAN communication

i Use the PING utility to verify the LAN connectivity by opening a 
command window and typing 
ping ip.adress  (e.g. ping 10.1.1.101) “Verify that the IP Address 
is correct” on page 126 .

5 Add an additional instrument or device to the network.

a Repeat step 4 on page 33 for each instrument or device on the 
network that requires the Bootp service.

b When finished, click Exit Manager.

c Click OK.

Configuring the Agilent BootP Service 

Agilent BootP Service starts automatically when your PC reboots. To 
change Agilent BootP Service settings, you must stop the service, make the 
changes, and then restart the service. Follow the procedures below to 
configure your Agilent BootP Service.
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Stopping the Agilent BootP service

1 From the Windows Control Panel, select Administrative Tools > Services. 
The Services screen appears.

2 Right- click Agilent BootP Service.

3 Select Stop.

4 Close the Services and Administrative Tools screens.

Editing the settings

1 Follow Start > Programs > Agilent BootP Service and select EditBootPSettings. 
The BootP Settings screen appears.

2 When the BootP Settings screen is first opened, it shows the default 
settings from installation.
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Editing BootP Addresses

1 Press Edit BootP Addresses... to edit the existing tabfile.

Figure 5

A default TabFile was created at installation and is located at C:\
Documents and Settings\All Users\Application Data\Agilent\BootP\TabFile. It 
contains configuration information entered on this screen.

2 In the Edit BootP Addresses... screen press Add... to create a new entry or 
select an existing line from the table and press Modify... or  Delete to 
change the TabFile.

If you change the IP address, it will be necessary to power cycle the 
instrument for the changes to take effect.

3 Leave Edit BootP Addresses... by pressing Close.

4 Exit BootP Settings by pressing OK.

Configuring logging

1 Check Do you want to log BootP requests? to enable logging

OR

Uncheck Do you want to log Bootp requests? to stop logging.

A default log file was created at installation and is located at C:\
Documents and Settings\All Users\Application Data\Agilent\BootP\LogFile. It 
contains an entry for every time a device requests configuration 
information from Bootp.

2 Click OK to save the values or Cancel to discard them. The editing ends.
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Restarting the Agilent BootP service

1 In the Windows Control Panel, select Administrative Tools > Services. The 
Services screen appears.

2 Right- click Agilent BootP Service and select  Start.

3 Close the Services and Administrative Tools screens.

This completes configuration.
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GPIB and USB-GPIB Communication

If you are not using GPIB communication, skip this section.

Analytical instruments that communicate with the Agilent ChemStation via 
GPIB require a GPIB board to be installed in your computer. You can use 
an Agilent 82350A, the Agilent 82350B PCI high- performance GPIB 
interface card, the Agilent 82357A USB- GPIB Interface or the Agilent 
82357B USB- GPIB Interface.

Using GPIB and USB-GPIB Communication

Some analytical instruments that communicate with the Agilent 
ChemStation Rev. A.xx.xx via GPIB may continue to use GPIB connection 
for communication with ChemStation Rev. B.04.0x. In addition, a 
USB- GPIB Interface can be used. For details, please refer to Table 6 on 
page 39.

NOTE Agilent LC 1100 and 35900E using GPIB communication are no longer supported. These 
systems need an upgrade to LAN connection PRIOR to the upgrade to ChemStation Rev. 
B.04.0x.

Table 6 GPIB and Analytical Hardware Compatibility Matrix

Instrument Type Agilent 82350 A Agilent 82350 B Agilent USB-GPIB 
Interface 82357A

Agilent USB-GPIB 
Interface 82357B

Agilent 1100/1200 LC No No No No

Agilent 1120 Compact LC No No No No

HP 5890 GC, 4890D GC No Yes No Yes

Agilent 7890A GC System No No No No

Agilent 6890N GC No No No No

Agilent 6890A and 6890 Plus GCs No Yes No Yes
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A document describing the installation of the SICL libraries in order to 
control the GPIB systems can be found on the ChemStation DVD- ROM in 
the Manual/Installation folder.

Agilent 82350 A/B GPIB Interface Card

The Agilent 82350 is a PCI GPIB interface card. Therefore no additional 
settings such as changing the I/O base address are required.

Agilent 6850 GC No No No No

G1600A Capillary Electrophoresis Yes Yes Yes Yes

7100 Capillary Electrophoresis No No No No

35900E No No No No

Table 6 GPIB and Analytical Hardware Compatibility Matrix

Instrument Type Agilent 82350 A Agilent 82350 B Agilent USB-GPIB 
Interface 82357A

Agilent USB-GPIB 
Interface 82357B

CAUTION Electronic boards and components are sensitive to electrostatic discharge (ESD). 

ESD can damage electronic boards and components.

➔ Be sure to hold the board by the edges and do not touch the electrical components. 
Always use an ESD protection (for example, an ESD wrist strap) when handling 
electronic boards and components.
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Installing and Configuring the Agilent GPIB Interface Board

Installing the GPIB Interface Board in your PC

To install the GPIB interface board refer to your computer manual or 
follow the brief instructions below.

1 Turn off and unplug your computer, then remove the computer's 
cover(s).

2 Select any empty slot to install your 82350 GPIB board. However, if 
possible, avoid placing the board in the last slot as there may be 
interference with the PC cabinet after connecting the GPIB cable.

3 Loosen the mounting screw and remove the selected empty slot's rear 
plate.

4 Holding the board by its edges, insert the board into its slot. Make 
certain that the board's edge connector is fully seated. Lock the board 
into place with the mounting screw.

5 Replace the computer's cover(s). Plug in, and restart the computer.

WARNING Your computer may be partially energized when switched off, as long as the power 
cord is plugged in. 

Repair work can lead to personal injuries, e.g. electric shock, when the cover is 
opened and the computer is connected to power.

➔ Turn OFF and unplug your computer and all attached electrical devices before 
removing any covers.

CAUTION Electronic boards are static sensitive and should be handled with care so as not to 
damage them. Touching electronic boards and components can cause electrostatic 
discharge (ESD). 

ESD can damage electronic boards and components.

➔ Be sure to hold the board by the edges and do not touch the electrical components. 
Always use an ESD protection (for example, an ESD wrist strap) when handling 
electronic boards and components.
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6 After installing the GPIB board in the computer, it is necessary to 
install the corresponding driver and configuration software located on 
the Agilent ChemStation DVD in the IO Libs directory. Refer to the IO 
Libraries Suite 15.0 installation guide also found on the ChemStation 
DVD in the Manuals folder.

GPIB Cabling

When connecting GPIB devices together, there are several basic rules that 
should be observed.

1 Whenever possible, turn off and unplug the computer and all attached 
devices -  before the GPIB cables are installed.

2 Before connecting any analytical instrument to a GPIB cable, consult 
the documentation supplied with each device and determine its GPIB 
address. No two devices connected to the Agilent ChemStation may 
have the same address. Alter their addresses as necessary to avoid any 
duplication. Write down each GPIB address. This information will be 
needed later.

3 Try to use short GPIB cables that are two meters long or less.

• GPIB cable (0.5 m) (10833D)

• GPIB cable (1.0 m) (10833A)

• GPIB cable (2.0 m) (10833B)

• GPIB cable (4.0 m) (10833C)

4 Connect one end of a GPIB cable to the computer’s GPIB connector.

NOTE The Agilent ChemStation does not support GPIB extenders.

NOTE Be certain that you properly tighten all GPIB connectors. A poor connection causes errors 
that are difficult to diagnose.
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5 Connect GPIB devices in a chain. A chain occurs when a GPIB device 
is connected to the next GPIB device, and it is, in turn, connected to 
the next, and so on. Avoid star configurations (connecting all of the 
devices to a central point).

Installing and Configuring the Agilent 82357A/B USB - GPIB 
Interface and Driver

Before connecting the USB- GPIB interface with the computer, it is 
necessary to install the corresponding driver and configuration software 
located on the Agilent ChemStation DVD in the IO Libs directory. Refer to 
the IO Libraries Suite installation guide also found on the ChemStation 
DVD in the Manuals directory. 

CAUTION The bus is not designed for dynamic configuration according to the IEEE 488 
specification for the General Purpose Instrument Bus (GPIB).

Cycling power on a GPIB instrument that is connected to the bus while other GPIB 
instruments are actively communicating to the GPIB controller can induce electrical 
spikes that may potentially corrupt the GPIB protocol. In extreme cases, this may 
require cycling power on all instruments, including the GPIB controller (i.e. typically the 
Agilent ChemStation).

➔ Close ChemStation programs before cycling power of a GPIB instrument or 
modifying the GPIB connection.
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Instrument Communication

Be sure to set up the communication channel between the instrument and 
the PC prior to operating the system. 

Connecting an Agilent 1100/1200 Series LC to the 
Agilent ChemStation 

You can connect the following modules of the Agilent 1100/1200 Series LC 
to your Agilent ChemStation using LAN:

• Agilent 1100/1200 Autosampler (ALS)

• Agilent 1100/1200 Well Plate Autosampler (WPS)

• Agilent 1100/1200 Dual Loop Autosampler (DLA)

• Agilent 1100/1200 Thermostatted Autosampler (ALS)

• Agilent 1100/1200 Pumping System (PMP)

• Agilent 1100/1200 Diode Array Detector (DAD)

• Agilent 1100/1200 Multi Wavelength Detector (MWD)

• Agilent 1100/1200 Variable Wavelength Detector (VWD)

• Agilent 1100/1200 Fluorescence Detector (FLD)

• Agilent 1100/1200 Refractive Index Detector (RID)

• Agilent 1100/1200 Thermostatted Column Compartment (TCC)

• Agilent 1100/1200 Chip Cube Interface (CC)

• Agilent 1100/1200 Fraction Collector (AS/PS)

• Agilent 1100/1200 Micro Fraction Collector (MFC)

• Agilent 1100/1200 Vacuum Degasser

Instrument cabling 

Installation and interconnection of your Agilent 1100/1200 Series LC 
modules are described in more detail in the Agilent 1100/1200 Series 
module user manual supplied with each module.
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• Connect a controller- area network (CAN) cable between each of your 
Agilent 1100/1200 modules except the vacuum degasser. One CAN cable 
is included with each Agilent 1100/1200 module.

• Connect a remote cable (part number 5061- 3378) between the Vacuum 
Degasser and one other Agilent 1100/1200 module.

• Connect the Agilent 1100/1200 module with the G1369A LAN card 
inserted to your LAN component, using the appropriate EtherTwist 
10BaseT cable.

• The G1315C DAD- SL or G1365C MWD- SL as well as the G1314D VWD 
or G1314E VWD SL Plus detectors have on- board LAN communication, 
use the appropriate EtherTwist 10BaseT cable.

Connecting an Agilent MSD/MS System

With Agilent ChemStation revision B.04.0x the following MSD/MS systems 
are supported: 

Please refer to the System Installation Manual for the Agilent 1100/1200 
Series LC/MSD or Agilent 6100 Series Single Quad LC/MS for details. 

NOTE We recommend connecting the LAN card cable to an Agilent 1100/1200 detector. Using the 
G1315C DAD or G1365C MWD this is a definitive must. If no Agilent detector is used, please 
contact your Agilent representative to get information about the insertion point of the 
communication card.

Table 7 Supported MS Instruments

Family Products

Agilent 1100/1200 Series LC/MSD G1946B / G1946C /G1956A / G1956B

Agilent 6100 Series Single Quad LC/MS G6110A /G6120A /G6130A / G6140A
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Connecting an Agilent CE instrument

Connecting an Agilent G1600 CE Instrument to the Agilent ChemStation 
Computer (using GPIB)

As described in your Agilent G1600 CE instrument User’s Guide 
(part- number G1600- 90009), you need two GPIB cables and one 
start/stop- cable in order to operate the instrument from the 
Agilent ChemStation. The first GPIB cable transfers data from the 
mainframe instrument to the built- in diode array detector. The second 
GPIB cable connects it to the Agilent ChemStation computer. As 
time- critical events such as start/stop impulses are not transmitted via the 
GPIB bus, an additional start/stop- cable is required. It connects the core 
instrument to the built- in detector.

Connect a GPIB cable from the GPIB connector at the rear of the Agilent 
CE instrument to the GPIB connector on the computer. See Figure 6 on 
page 46.

Figure 6 Rear of Agilent G1600 CE Instrument

NOTE Agilent CE instruments are supported with English operating systems only.
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Connecting an Agilent G1600 CE Instrument to the Agilent ChemStation 
Computer (using USB-GPIB Interface)

Since Agilent ChemStation Rev. B.01.03 it is possible to use the 82357A 
USB- GPIB Interface. This connection requires the 82357A USB- GPIB 
Interface, one GPIB cable, and one start/stop- cable in order to operate the 
instrument from the Agilent ChemStation. The USB- GPIB interface 
connects the CE instrument to the Agilent ChemStation computer. The 
GPIB cable transfers data from the mainframe instrument to the built- in 
diode array detector. As time- critical events such as start/stop impulses 
are not transmitted via the GPIB bus, an additional start/stop- cable is 
required. It connects the core instrument to the built- in detector.

Connect the USB- GPIB Interface from the GPIB connector at the rear of 
the Agilent G1600 CE instrument to the USB connector on the computer. 
See Figure 7 on page 47.

Figure 7 USB-GPIB Interface Connection

Default GPIB Addresses 

The Agilent G1600 CE instrument is shipped with the default GPIB 
addresses listed in Table 8 on page 48.
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Connecting an Agilent G7100 CE Instrument to Agilent ChemStation 
Computer

The Agilent G7100 CE instrument is controlled via LAN connection. For 
more information, please refer to the Agilent G7100 Capillary 
Electrophoresis System User Manual. 

Connecting Miscellaneous Instruments to the Agilent ChemStation 

Connecting Miscellaneous Instruments to the Agilent ChemStation 

In addition to the Agilent 1100/1200 Series, you can connect the following 
stand- alone analytical instrument to your Agilent ChemStation: 

• Agilent 35900E dual channel interface

To install this instrument, see the operator’s handbook shipped with the 
instrument.

35900E Communication

These instruments are using LAN connection for communication, the setup 
is similar to the LAN set up for LC instruments. Please see the operators 
handbook shipped with the instrument.

If you configure more than one module of the same type, you must change 
the default settings so that each module has a unique IP address. For 
further details, please refer to the instrument handbooks.

Table 8 Agilent G1600 CE Instrument Default GPIB Addresses

Agilent CE Component Default GPIB Address

Mainframe 19

Built-in diode-array detector 17
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Remote Control Cabling

All modules of an instrument that accept timetable entries or which go 
into the run mode during an analysis must be included in the remote 
control loop. In general, each module must be connected to the other 
devices with a remote control cable. 

The 35900E dual channel interface use APG remote, but the two remote 
connectors are not pass- through connections. When you operate the 
35900E with both channels simultaneously, only the A- channel remote will 
be connected. The B- channel acts in synchronization with the A- channel 
and will react to the remote signals from the A- channel remote connector. 
The only time you connect a remote cable to the B- channel remote 
connector is if you wish to operate the B- channel independently. In this 
mode, one instrument may start and stop the A- channel while another 
instrument has control of the B- channel.
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Overview

Refer to the following, based on the type of installation you are 
completing: 

• “Initial installation” on page 53

• “Adding instruments to an existing installation” on page 64

• “Upgrading from previous revisions” on page 65
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Initial installation

The following procedure describes how to install the Agilent ChemStation 
for the first time. 

See “Adding instruments to an existing installation” on page 64 for 
instructions on adding an instrument to an existing Agilent 
ChemStation.

1 Ensure all the steps defined in the section “Installation Preparation” on 
page 23 have been completed.

2 Ensure that no open programs are running on your system.

3 Insert the Agilent ChemStation DVD into the DVD drive. 

4 From the Start menu in the Task Bar, select Start > Run.

5 At the command line, type 
drive:\Install\Setup.exe  (for example, E:\Install\Setup.exe), 
then click OK. 

The Setup Wizard starts.

6 The Setup Wizard checks for the prerequisites PDF- XChange 4.0 and 
Microsoft .NET Framework 3.5 SP1.

a Confirm installation of required components by pressing Install. For 
Microsoft .NET Framework 3.5 SP1 also read and accept the License 
Agreement.

NOTE The PDF-XChange printer will only be visible in the Start Menu > Settings > Printers and 
Faxes until the computer is restarted.

When ChemStation is started, another temporary printer is created called "ChemStation 
PDF" based on the PDF-X-Change printer. While any ChemStation session is running, 
ChemStation PDF will also be listed in the Start Menu > Settings > Printers and Faxes
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Figure 8 Agilent ChemStation Prerequisites Setup

Once the prerequisites are fulfilled the ChemStation Setup Wizard 
greets.

b In the next step the End- User License Agreement is presented and 
needs to be read.

Once its acceptance is indicated continuation by Next is possible.

Figure 9 License Agreement
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7 The destination folder for installation of ChemStation's files is 
presented. A different folder may be selected using the green browse 
button. Navigate and create new folders (optional) to determine the 
destination for ChemStation. Confirm with OK.

Figure 10

8 Once the files are copied and registered this phase of ChemStation's 
installation is completed. Press Finish to continue.

NOTE If the destination directory already exists (e.g from a previously removed installation of 
ChemStation) that directory will be moved away by renaming it to unique <directory>_xxx 
(e.g. Chem32_001).
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Figure 11

9 The Setup Wizard - Instruments screen displays and lets you select 
instrument- types or data analysis. 

a Up to four instruments can be configured by the appropriate 
add- button, e.g. by pressing Add LC or Add CE.

• This will cause an appropriate entry to appear to the right in the 
list of selected instruments for ChemStation: 
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Figure 12

• If the wrong kind of instrument was added, a right mouse click 
onto an instrument from the list offers to Delete the selected one 
only or to Delete all all selected ones together.
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b Alternatively one of the Data Analysis options can be selected, e.g. by 
pressing Data Analysis Only.

Data Analysis ChemStation

• If some instruments are selected already, a warning informs you 
that the previously selected instruments will be replaced. To 
configure Data Analysis confirm continuation by Yes.

Figure 13

• Only one kind of Data Analysis may be selected.

• The selected Data Analysis will itself be replaced by selecting a 
different Data Analysis or an instrument from the buttons to the 
left, like e.g. by pressing Add LC.

10 Select a functionality in the list of nodes to the right

• To choose a functionality the check box next to this functionality has 
to be marked.

NOTE Please observe the maximum possible number of instruments as lined out in “Number of 
Instruments Supported” on page 14.
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• The list's nodes may be expanded or collapsed by clicking with the 
mouse onto the [+] or [-] symbol to display or hide additional 
available functionality.

11 Once the right set of instruments or the Data Analysis is determined 
press Next.

The Setup Wizard - Licenses screen is displayed.

12 To install a license, enter the appropriate registration number found on 
the Software Registration Label as license into the central field at the 
bottom and click Add. Enter only a single license at a time.

Figure 14 Example License Registration Label

HINT Look for products from the right column of product numbers to locate the License 
Registration Label of a suitable product.
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Figure 15

The entered licenses will show up in the center column of provided 
license keys.

13 Repeat the previous step till all required licenses are added.

Once all the required licenses are entered the license entry process may 
be left by clicking Finish.

14 When Setup has finished installing the software click Finish.

15 If Use configuration assistant to configure LC systems was selected, the 
Configuration Assistant will be launched. See “Configuring the 
Instruments” on page 87

NOTE You may enter the required licenses in any order - the required licenses will automatically 
be assigned to one of the matching modules.
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16 Complete the Configuration Editor screens. See “Configuring the 
Instruments” on page 87 for procedures on configuring your 
instrument(s).

17 Store your DVD and any license numbers in a safe place. These will be 
required if you wish to reinstall your software or add a new instrument 
module or license.

18 Run Installation Verification Tool to check out the installation. Installation 
Verification is documented in “Agilent ChemStation Installation 
Verification” on page 114.

Activating the XML-Based Interface

If you are using a LIMS or other external data collection systems, the 
Agilent ChemStation provides an XML interface to allow it to read sample 
input lists, analyze the samples, and then output result data back to the 
LIMS system. To enable this functionality, you will need to make changes 
to the CHEMSTATION.INI file. Please refer to the XML and LIMS Interface 
Guide found in the Manuals folder on the Agilent ChemStation DVD for 
full details. 
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Installing the Control Charts Reports

The following process adds control charts to your report menu.

After you have installed your Agilent ChemStation you are ready to 
install the ChemStation Control Charts feature.

1 Start e.g. the Agilent A/D ChemStation.

2 Find the Agilent ChemStation command line. The command line is a 
text entry field across the bottom of the Agilent ChemStation program 
window.

3 At the command line, type 
MACRO STARTCHT.MAC,GO

4 Press Enter.

5 A dialog box providing information about the installation appears.

NOTE Installation of Microsoft Excel 2000 is required to use this feature.
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6 Select Help from this dialog box for information about using Control 
Charts with your Agilent ChemStation.

7 Select OK to install Control Charts feature to your Agilent ChemStation.
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Adding instruments to an existing installation

1 To add further instruments select Programs > Agilent ChemStation > Add 
Instrument

This starts the ChemStation Setup Wizard for Instruments.

2 Follow steps step 10 on page 58 – step 17 on page 61 of “Initial 
installation” on page 53.

3 Run Installation Verification Tool to check out ChemStation after adding 
instruments. Installation Verification is documented in “Agilent 
ChemStation Installation Verification” on page 114.

NOTE A modification or deletion of the already configured instrument(s) is not allowed.

NOTE Please observe the maximum possible number of instruments as lined out in “Number of 
Instruments Supported” on page 14.
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Upgrading from previous revisions 

General Upgrade Procedure for ChemStation Systems

Licenses in ChemStation Rev. B.04.0x

ChemStation Rev. A.xx.xx License numbers in general allow the upgrade to 
ChemStation Rev. B.04.0x. In addition, new installations can be performed 
using license numbers purchased for ChemStation Rev. A.xx.xx.

Agilent Training licenses (tx0000xxxx) are not valid for ChemStation Rev. 
B.04.0x. If your system was installed using a training license, a valid full 
license needs to be installed using the Add Licenses utility prior to or 
during the upgrade.

NOTE Before you upgrade your system, we strongly recommend that you back up your complete 
system.

NOTE Before starting the upgrade, read carefully the sections regarding the general upgrade, as 
well as the instrument-specific upgrade information. If you have Add-On Solution software 
installed, read the section “Upgrade Procedure for ChemStation Systems with Add-On 
Solutions” on page 73, prior to starting the upgrade procedure. Verify that your Add-On 
Solution is supported on ChemStation B.04.01. If you have used GPIB communication, read 
the section “GPIB and USB-GPIB Communication” on page 39 prior to starting the upgrade 
procedure.
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Automatic Upgrade of ChemStation Rev. B.0x.0x to ChemStation 
Rev. B.04.02 SP1

The following describes how to upgrade an existing Agilent ChemStation. 
See “Adding instruments to an existing installation” on page 64 for 
instructions on adding only an instrument to an existing Agilent 
ChemStation.

1 Insert the Agilent ChemStation DVD into the DVD drive. 

2 From the Start menu in the Task Bar, select Start > Run.

3 At the command line, type 
drive:\Install\Setup.exe  (for example, E:\Install\Setup.exe), 
then click OK. 

The Setup Wizard starts.

4 The Setup Wizard checks for the prerequisites PDF- XChange 4.0 and 
Microsoft .NET Framework 3.5 SP1.

Preparations • Ensure that all preparations have been completed. See “Installation Preparation” on page 23
• Ensure that no open programs are running on your system.

NOTE ChemStation B.04.02 SP1 is supported on Windows XP and Windows Vista only. 
ChemStation B.01.01 up to B.02.0x was also supported on either Windows 2000 or 
Windows XP. So, in order to upgrade to ChemStation B.04.02 SP1, the Windows 2000 
operating system needs to be updated PRIOR the ChemStation upgrade. Please check as 
well the minimum “Minimum PC Requirements” on page 10.

NOTE Before starting the upgrade, close all programs and reboot your system. Verify the LAN 
communication software. The Agilent BootP Service needs to be installed in place of the 
CAG BootP Server, which is no longer supported.
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a Confirm installation of required components by pressing Install. For 
Microsoft .NET Framework 3.5 SP1 also read and accept the License 
Agreement.

Figure 16 Agilent ChemStation Prerequisites Setup

Once the prerequisites are fulfilled the ChemStation Setup Wizard 
greets.

b In the next step the End- User License Agreement is presented and 
needs to be read.

Once its acceptance is indicated continuation by Next is possible.

NOTE The PDF-XChange printer will only be visible in the Start Menu > Settings > Printers and 
Faxes until the computer is restarted.

When ChemStation is started, another temporary printer is created called "ChemStation 
PDF" based on the PDF-X-Change printer. While any ChemStation session is running, 
ChemStation PDF will also be listed in the Start Menu > Settings > Printers and Faxes
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Figure 17 License Agreement

5 The ChemStation Install Wizard checks for the existence of an installed 
ChemStation.

NOTE If an A.xx.xx ChemStation is detected, the upgrade installation is terminated. For upgrade of 
ChemStation A.xx.xx see “No Automatic Upgrade Rev. A.xx.xx to ChemStation Rev. B.04.02 
SP1” on page 70.
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The ChemStation Install Wizard reports the detected ChemStation revision 
and the location of the current installation. By pressing Next the 
upgrade of this ChemStation begins.

6 The current installation directory (e.g. c:\chem32) from earlier 
ChemStation B.0x.0x is first preserved by moving it away. This is done 
by renaming it to a unique <directory>_xxx (e.g. c:\Chem32_001).

7 A cleanup of the operating system's registry, PATH variable and 
ChemStation.ini is conducted. Then the ChemStation B.04.02 SP1 files 
are copied to the now free destination directory (e.g. c:\Chem32).

Eventually the licenses, instrument configuration, communication 
parameters and content of these directories are also copied to the fresh 
installation:

• The instrument directories (e.g. _INSTPATH$=C:\Chem32\1\)

• The data directories (e.g. _DATAPATH$=C:\Chem32\1\DATA\)

• The sequence template directories (e.g. _CONFIGSEQPATH$=C:\Chem32\
1\SEQUENCE\)

NOTE If moving the current installation is not possible (e.g. due to a remaining program accessing 
a file within c:\Chem32) the ChemStation Setup Wizard will prematurely end the upgrade.
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• The master method directories (e.g. _CONFIGMETPATH$=C:\Chem32\1\
METHODS\)

• The spectra libraries directory (e.g. _LIBPATH$=C:\CHEM32\SPECLIBS\)

Now the upgrade to ChemStation B.04.02 SP1 is completed.

8 Store your DVD and any license numbers in a safe place. These will be 
required if you wish to reinstall your software or add a new instrument 
module or license.

9 Run the Installation Verification Tool to verify the upgrade of ChemStation. 
Installation Verification is described in “Agilent ChemStation 
Installation Verification” on page 114.

No Automatic Upgrade Rev. A.xx.xx to ChemStation Rev. B.04.02 
SP1

ChemStation revisions A.xx.xx cannot be upgraded automatically to 
B.04.02 SP1. If your ChemStation has a Rev. A.xx.xx you have to install 
ChemStation on a new system and move the required data manually. The 
new system has to match the required hardware and software 
specifications.

The automatic upgrade mode is supported for ChemStation Rev. B.01.03 or 
higher. 

1 If nevertheless setup.exe from ChemStation DVD is started, the 
prerequisites are fulfilled and the Agilent ChemStation Setup wizard detects 
the presence of ChemStation Rev. A.xx.xx, the installation will be 
aborted.
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Manual Upgrade from ChemStation Rev. A.xx.xx to Rev. B.04.02 
SP1

In order to upgrade from a revision A.xx.xx, the PC hardware and 
software requirements as well as the firmware requirements need to be 
checked. Once the prerequisites for ChemStation B.04.02 SP1 are met, 
install ChemStation B.04.02 SP1 on a supported, clean system.

Backup the required user- created files of interest manually to the 
appropriate directories. Be sure to backup all your necessary data and 
remove ChemStation A.xx.xx.

Then copy the required user- created files of interest manually to the 
appropriate directories. 

Unsupported Upgrades to ChemStation Rev. B.04.02 SP1

The following instruments/modules or connections types are not supported 
with ChemStation Rev. B.04.0x:

• all HP 1050, 1046, 1049, 1090 modules or instruments

• GPIB connection for all Agilent LC 1100/1200 modules

• GPIB connection for 35900E

For the non supported instruments/modules, an upgrade to ChemStation 
Rev. B.04.0x is not possible.

NOTE ChemStation B.04.02 SP1 is supported on Windows XP and Windows Vista only. 
ChemStation A.09.03 for example was supported on either Windows NT 4.0 or Windows 
2000, in order to upgrade to ChemStation B.04.02 SP1 the operating system needs to be 
updated PRIOR the ChemStation upgrade. Please check as well the PC minimum 
requirements, “Minimum PC Requirements” on page 10.

NOTE If you load methods, sequences, etc. within Rev. B.04.0x, they are saved using the new file 
format. Files saved in ChemStation Rev. B.04.0x are not backwards-compatible with any 
ChemStation Rev. A.xx.xx.
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Instrument Specific Upgrade Instructions

The instrument specific upgrade instructions can differ depending if the 
system is upgraded from Rev A.xx.xx ChemStation or Rev. B.0x.0x 
ChemStation to ChemStation B.04.02 SP1.

LC-Specific Upgrade Instructions: 

valid to Upgrade Rev. A.09.03/A.10.01/A.10.02 to Rev. B.04.02 SP1

• LC 1100 modules communication

The following system- created configuration file for LC 1100 modules 
needs to be copied to the upgraded ChemStation when you do a manual 
upgrade of ChemStation A.XX.XX: hpchem\instrument number\clusterx.mth

• Wellplate Sampler Configuration

The following user- created Wellplate definition file needs to be copied 
to the upgraded ChemStation when you do a manual upgrade of 
ChemStation A.XX.XX: hpchem\instrument number\*.wpt

A/D-Specific Upgrade Instructions

35900E

The G2072BA and G2073BA A/D products require a 35900E with LAN 
communication.

CE/MS-Specific Upgrade Instructions

CE/MS ChemStation consists of a G1601AA CE ChemStation including a 
G2201AA MS ChemStation. The G2201 is an Add- On program to the CE 
ChemStation.
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Upgrade Procedure for ChemStation Systems with Add-On 
Solutions

All Add- On software products need to be uninstalled before any automatic 
upgrade of an existing ChemStation Rev. B.0x.0x or higher to ChemStation 
Revision B.04.0x. There is no automatic upgrade for Add- On products. The 
different behaviors regarding uninstallation are summarized in the table 
below. The Add- On software must be reinstalled following the ChemStation 
upgrade.

NOTE Verify PRIOR to the upgrade, that your installed Add-On Solution is supported on 
ChemStation B.04.02 SP1. Not every Add-On Solution software is initially supported. 
Supported Add-On Solutions for LC and CE ChemStation with the respective minimum 
revision are documented in Table 9 on page 73. Please refer to the ChemStation Upgrade 
Preparation Guide for Information about Add-on software for other instrument techniques.

Table 9 Supported Add-On Solution Products with ChemStation Rev. B.04.02

Add-On Solution for ChemStation 
Rev. B.04.02 SP1

Required Revision for ChemStation 
Rev. B.04.02 SP1

Uninstall from ChemStation

G2181BA ChemStore Client/Server B.04.02 Uninstalls completely from the Add/Remove 
Programs in Control Panel, including entries in 
the chemstation.ini.

G2183BA Security Pack B.04.02 Uninstall done by ChemStore

Purify B.01.01 Uninstalls completely from the Add/Remove 
Programs in Control Panel, including entries in 
the chemstation.ini.

G2182BA GPC Gel Permeation 
Chromatography

B.01.01 Uninstalls completely from the Add/Remove 
Programs in Control Panel, including entries in 
the chemstation.ini.

G3383AA Control for CTC PAL 
Autosampler for LC and LC/MS 
Systems

A.01.06 Uninstalls completely from the Add/Remove 
Programs in Control Panel, including entries in 
the chemstation.ini.

G2201BA CE/MS B.03.01 Uninstalls completely from the Add/Remove 
Programs in Control Panel, including entries in 
the chemstation.ini.
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During the installation of an Add- On solution, certain information is 
written to a specific file (located in the windows directory of your system) 
in order to maintain the Add- On solution program:

• ChemStation Revision A: win.ini

• ChemStation Revision B: chemstation.ini

During the upgrade process, the upgrade program reads all 
win.ini/chemstation.ini entries and detects Add- On solutions by their entries 
in this file. Uninstalling the ChemStation software without previously 
removing the Add- On solution triggers an alert during the upgrade 
process.

Installed products belonging to the ChemStation Plus Family, such as 
ChemStore or ChemAccess, must be uninstalled using the standard 
Windows uninstall procedure (Start > Settings > Control Panel  > Add or Remove 
programs). Uninstall these products using the Windows routine prior to 
upgrading the ChemStation.

In addition, some Add- On programs create certain entries in the 
win.ini/chemstation.ini file that are not removed during the uninstallation; 
these entries may need to be MANUALLY removed from the 
win.ini/chemstation.ini file AFTER the uninstallation of the Add- On solution, 
but PRIOR to the upgrade installation.

Upgrade from ChemStation B.0x.0x Revision with Add-On Solution

Required steps for performing an upgrade of ChemStation revision B.0x.0x 
with installed Add- On solution. e.g. Purify:

Uninstall the Add- On Solution software using the standard Windows 
uninstall procedure (Control Panel > Add/Remove programs). During this 
uninstallation process, the system removes the Add- On solution entries 
corresponding to the just uninstalled Add- On solution program. If more 
Add- On Solutions are installed on the system, each Add- On solution needs 
to be removed using Add/Remove Programs.
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Table 10 ChemStation Rev. B.0x.0x Add-On-Solution Uninstall Instructions - Summary

Add-On Solutions for 
ChemStation B.0x.0x

Rev. Add-On Entries in ChemStation.ini (may need to be 
removed manually AFTER running the Uninstallation via 
ADD/REMOVE programs)

Add/Remove 
Programs from 
Windows

G2181BA
ChemStore Client/Server

starting 
B.03.02 
SR1

[PCS]
ChemStore C/S =C:\CHEM32\ChemStor\database
[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\ChemStor\hpdbif00.mcx
ChemStore C/S =C:\CHEM32\ChemStor\database

Yes, removes 
completely all 
related entries in 
chemstation.ini

G2183BA
Security Pack

starting 
B.03.02 
SR1

No Add-On entries in win.ini No, will be 
uninstalled during 
ChemStore 
uninstallation.

Purify starting 
B.01.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\Purify\bin\inl_puri.mcx
[Purify]
Version = xx.xx
Path=c:\Purify
.....

Yes, removes 
completely all 
related entries in 
chemstation.ini

Method Validation Pack up to 
A.02.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\CORE\hpca.mac
MVPrevSeqFile=... MVPrevSeqPath=... 
MethodValidationMode=1

Yes, removes 
completely all 
related entries in 
chemstation.ini

Easy Access starting 
A.04.00

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\CORE\ezxmmain.mac

Yes, removes 
completely all 
related entries in 
chemstation.ini

Data Browser starting 
A.02.00

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\CORE\aevgen.mac

Yes, removes 
completely all 
related entries in 
chemstation.ini

G3383AA Control for CTC 
PAL Autosampler for LC and 
LC/MS Systems

starting 
A.01.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\Chem32\CTC\CTC_TOP.MAC
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Upgrade from ChemStation Revision A.xx.xx with Add-On Solution

Required steps for performing an upgrade of ChemStations A.xx.xx 
with installed Add- On solution. e.g. GC Companion:

1 Uninstall the Add- On Solution software using the standard Windows 
uninstall procedure (Control Panel > Add/Remove programs) 

2 From the Start menu in the Task Bar, select Start > Run.

3 Type 
Win.ini into the command line and press OK. The win.ini file opens.

CTC Cycle Composer 1.5.2 [PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\CORE\PALSEQ.mac

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the 
chemstation.ini

Active Splitter starting 
A.01.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\CORE\actsplit.mac

Yes, removes 
completely all 
related entries in 
chemstation.ini

G1979A Multi-Signal Output 
Accessory

starting 
A.01.01

[[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CHEM32\CORE\G1979A.mac

Yes, removes 
completely all 
related entries in 
chemstation.ini

Analyst starting 
1.4

No Add-On entries in win.ini

G2201A CE/MS starting 
B.01.01 

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDON1=C:\CHEM32\MS\MSTOP.MAC

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the 
chemstation.ini

Table 10 ChemStation Rev. B.0x.0x Add-On-Solution Uninstall Instructions - Summary

Add-On Solutions for 
ChemStation B.0x.0x

Rev. Add-On Entries in ChemStation.ini (may need to be 
removed manually AFTER running the Uninstallation via 
ADD/REMOVE programs)

Add/Remove 
Programs from 
Windows
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4 Within the [PCS] and [PCS,x] section where x reflects the number of 
the instruments installed, search for the Add- On solution- related 
entries. e.g. for ChemStation 
Companion ADDONS=1 ADDON1=C:\HPCHEM\PUI\PUITOP.mac. 

The win.ini entries related to the installed Add- On solutions are listed 
in Table 11 on page 77. 

5 Delete the Add- On solution entries corresponding to the just uninstalled 
Add- On solution program. If more Add- On Solutions are installed on 
the system, the variable ADDONS=x must be decremented to represent 
the number of the remaining Add- On solutions, since the Add- On 
programs need to be deinstalled separately.

6 Save and close the win.ini file.

7 Verify that all Add- On programs are removed, otherwise proceed with 
step 1 to uninstall further Add- On solutions. 

HINT When Add-On Solutions are installed on the system, the variable ADDONS=x is 
incremented and represents the number of installed Add-On solutions.

NOTE Refer to the corresponding software documentation of the Add-On Solution product for 
more details regarding the win.ini entries.

Table 11 ChemStation Rev. A.xx.xx Add-On-Solution Uninstall Instructions - Summary 

Add-On Solutions for 
ChemStation A.xx.xx 

Rev. Add-On Entries in Win.ini (may need to be removed 
manually AFTER running the Uninstallation via 
ADD/REMOVE programs)

Add/Remove 
Programs from 
Windows

ChemStore Client/Server up to 
B.03.02

[PCS]
ChemStore C/S =C:\HPCHEM\ChemStor\database
[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\ChemStor\hpdbif00.mcx
ChemStore C/S =C:\HPCHEM\ChemStor\database

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

Security Pack up to 
B.03.02

No Add-On entries in win.ini No, will be 
uninstalled during 
ChemStore 
uninstallation.
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Purify up to 
A.02.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\Purify\bin\inl_puri.mcx
[Purify]
Version = xx.xx
Path=c:\Purify
.....

Yes, removes 
completely all 
related entries in 
win.ini.

ChemAccess up to 
A.02.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\hpca.mac

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

Method Validation Pack up to 
A.02.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\hpca.mac
MVPrevSeqFile=... MVPrevSeqPath=... 
MethodValidationMode=1

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

GPC up to 
A.02.02

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\GPC\Gpc_top.mac
and GPC files need to be manual removed from the 
installation directory, refer to the readme.txt of the GPC 
Software 

Not possible, 
remove manually

Easy Access up to 
A.03.00

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\ezxmmain.mac

Yes, removes 
completely all 
related entries in 
win.ini.

Data Browser up to 
A.01.02

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\aevgen.mac

Yes, removes 
completely all 
related entries in 
win.ini.

Table 11 ChemStation Rev. A.xx.xx Add-On-Solution Uninstall Instructions - Summary 

Add-On Solutions for 
ChemStation A.xx.xx 

Rev. Add-On Entries in Win.ini (may need to be removed 
manually AFTER running the Uninstallation via 
ADD/REMOVE programs)

Add/Remove 
Programs from 
Windows
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G2080AA
Retention Time Locking for 
GC

A.05.02
A.06.01
B.01.01

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\RTL\RTLTOP.MAC

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

GC Companion no Rev. [PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\PUI\PUITOP.MAC

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

G2401AA
HeadSpace software for 
GCStandalone 

A.01.01 G2401AA is not an Add-on and is not added to the win.ini 
file. The G2401AA is not supported with the ChemStation.

No, must be 
removed 
separately.

G2922AA 
Integrated HeadSpace 
software for GC

A.01.0x [PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\HS\HSAddon.MAC

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

CC Mode A.03.02 [PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\CCMODE\bin\ccmode3.mcx
[CCMODE3]
Path=C:\CCMODE
etc.
[CCMODEIII]
version=À.03.xx

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

CTC Cycle Composer 1.5.2 [PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\PALSEQ.mac

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini 

Active Splitter A.01.00 [PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\actsplit.mac

Yes, removes 
completely all 
related entries in 
win.ini.

Table 11 ChemStation Rev. A.xx.xx Add-On-Solution Uninstall Instructions - Summary 

Add-On Solutions for 
ChemStation A.xx.xx 

Rev. Add-On Entries in Win.ini (may need to be removed 
manually AFTER running the Uninstallation via 
ADD/REMOVE programs)

Add/Remove 
Programs from 
Windows
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General Add-On Solutions

All Add- On software products need to be uninstalled before any upgrade 
of Rev. A.xx.xx or higher ChemStation to ChemStation Revision B.04.0x. 
There is no automatic upgrade of the Add- On products ChemStore and 
ChemStation Plus Security Pack. This Add- On software must be upgraded 
after the ChemStation upgrade.

ChemStore (up to B.03.02)

The G2181BA ChemStore software on top of ChemStation Rev. A cannot 
be updated to ChemStore B.04.02 software. The software needs to be 
uninstalled according to the uninstallation section of the ChemStore C/S 
Installation Guide. In addition, the following entries need to be deleted 
from the win.ini file:

In the [PCS] section:
ChemStore C/S =C:\HPCHEM\ChemStor\database

In all [PCS,x] sections:

G1979A Multi-Signal Output 
Accessory

A.01.00 [[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDONx=C:\HPCHEM\CORE\G1979A.mac

Yes, removes 
completely all 
related entries in 
win.ini.

Analyst 1.1.1/
1.4

No Add-On entries in win.ini

G2201A CE/MS A.09.03 
and 
higher

[PCS, Instrument number]
ADDONS=x (whereas x is the number of installed Add-Ons)
ADDON1=C:\HPCHEM\MS\MSTOP.MAC

Yes, but it is 
required to 
manually delete 
Add-On entries 
from the win.ini

Table 11 ChemStation Rev. A.xx.xx Add-On-Solution Uninstall Instructions - Summary 

Add-On Solutions for 
ChemStation A.xx.xx 

Rev. Add-On Entries in Win.ini (may need to be removed 
manually AFTER running the Uninstallation via 
ADD/REMOVE programs)

Add/Remove 
Programs from 
Windows
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ADDONS=x (whereas x is the number of installed Add- Ons) 
ADDONx=C:\HPCHEM\ChemStor\hpdbif00.mac ADDON(x+1)= C:\

HPCHEM\Core\mv.mac (for G2184A only)  
ChemStore C/S =C:\HPCHEM\ChemStor\database

ChemStore (above B.03.02 SR1)

The G2181BA ChemStore software on top of ChemStation Rev. B cannot 
be updated to ChemStore B.04.02 software. The software needs to be 
uninstalled according to the uninstallation section of the ChemStore C/S 
Installation Guide. The deinstallation program removes in addition all 
related section in the chemstation.ini file.

Security Pack 

The ChemStore uninstallation program removes all Security Pack- related 
items. A separate uninstallation is not possible.

LC-Specific Add-On Solutions

All Add- On software products need to be uninstalled before any upgrade 
of G2170AA/G2180AA ChemStation to G2170BA/G2180BA ChemStation 
Revision B.04.02 SP1. The Add- on software must be upgraded after the 
ChemStation upgrade.

GC-Specific Add-On Solutions

All Add- On software products need to be uninstalled before any upgrade 
of G2070AA ChemStation to G2070BA ChemStation B.04.0x. The Add- On 
software must be upgraded after the ChemStation upgrade.

Retention Time Locking

The G2080AA Retention Time Locking (RTL) Add- On software must be 
removed using the Add/Remove Programs in Control Panel. In addition, 
the RTL add- on entries in the win.ini file must be manually deleted before 
the Rev. B.04.0x GC ChemStation is installed.

Beginning with B.03.01, RTL is now integrated in the GC ChemStation.
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Companion 

The Companion Add- On software must be removed using the Add/Remove 
Programs in Control panel. In addition, the Companion add- on entries in 
the win.ini file must be manually deleted.

Beginning with B.01.01, the ChemStation Companion is included with the 
G2070BA GC ChemStation installation.

Headspace

ChemStation G2070BA supports the integrated G2924AA HeadSpace 
software.

The G2922AA Integrated Headspace software is supported only on 
G2070AA/G2071AA ChemStation and must be removed using the 
Add/Remove Programs in Control Panel before upgrading to GC 
ChemStation revision B.04.0x. In addition, the HeadSpace add- on entries 
in the win.ini file must be manually deleted.

Be aware, that the G2922AA registration number will not load the 
G2924AA software. The G2924AA software will need to be purchased.

The G2401AA A.01.01 Headspace software is a separate standalone 
program and is not supported with G2070BA/G2071BA ChemStation.

LC/MS-Specific Add-On Solutions

All Add- On software products, except Analyst, need to be uninstalled 
before any upgrade of G2710AA LC/MSD ChemStation to G2710BA 
LC/MSD ChemStation Revision B.04.0x. The Add- on software must be 
upgraded after the ChemStation upgrade.

Purify Software

Following Purification Add- On Solution Software cannot automatically be 
upgraded to next higher revision B.04.0x: G2262AA Purification/HiThruput 
SW module G2263AA Mass based fraction collection add- on SW (LC/MS 
specific) G2265AA Standalone Purification/HiThruput DA SW

The uninstallation shield of the Purification software removes all 
Purification related entries from the win.ini file.
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Active Splitter Software

The Active Splitter Add- On software must be removed using the 
Add/Remove Programs in Control Panel before the Rev. B.04.0x LC/MSD 
ChemStation software is installed.

G1979A Multi-Signal Output Accessory Software

The G1979A Multi- Signal Output Accessory Add- On software must be 
removed using the Add/Remove Programs in Control Panel before the Rev. 
B.04.0x LC/MSD ChemStation software is installed.

Analyst Software

If Analyst Rev. 1.1.1 Add- On software is installed, it must be upgraded to 
Analyst Rev. 1.4 before the Rev. B.03.0x LC/MSD ChemStation is installed. 
The Analyst Rev. 1.4 Add- on software should not be removed before the 
Rev. B.03.0x LC/MSD ChemStation software is installed. The Rev. B.03.0x 
LC/MSD ChemStation should be installed with the Analyst Rev. 1.4 still 
installed.

Easy-Access Software

The Easy Access Add- on software must be removed using the Add/Remove 
Programs in Control Panel before the Rev. B.04.0x LC/MSD ChemStation 
software is installed.

CTC Cycle Composer Software

The CTC Cycle Composer Add- on software must be removed using the 
Add/Remove Programs in Control Panel. In addition, the CTC Cycle 
Composer add- on entries in win.ini must be manually deleted before the 
Rev. B.04.0x LC/MSD ChemStation is installed.

Data Browser Software

The Data Browser Add- On software must be removed using the 
Add/Remove Programs in Control Panel before the Rev. B.04.0x LC/MSD 
ChemStation software is installed.



84 Installing LC and CE ChemStation

3 Installing the Agilent ChemStation
Uninstalling the Agilent ChemStation

Uninstalling the Agilent ChemStation

In some cases you might need to uninstall the Agilent ChemStation, for 
example, if you wish to install it in a different location.

To completely remove a Agilent ChemStation installation you can use the 
standard Windows uninstall procedure (Control Panel > Add or Remove 
programs). For uninstallation, please proceed with one of the following 
procedures:

Uninstalling the Agilent ChemStation

1 If the Agilent ChemStation is running close all sessions and reboot the 
computer.

NOTE Add-On solution software needs to be uninstalled using the standard Windows uninstall 
procedure (Control Panel > Add or Remove programs). Please uninstall these products 
using the Windows routine PRIOR to uninstalling Agilent Chemstation B.0x.0x. This also 
includes all Service Releases or Patches for the Agilent ChemStation that may have been 
delivered for the Agilent ChemStation revision you want to uninstall. The system may need 
you to manually modify the chemstation.ini file. Please refer to the corresponding software 
documentation of the Agilent ChemStation Plus products for details. 

See also 
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2 Select Start > Settings > Control Panel > Add or Remove Programs. Select 
Agilent ChemStation and press Remove.

Figure 18

3 Before starting the uninstallation you will be prompted to confirm the 
deinstallation. Click Yes to continue.

Figure 19

4 During uninstallation the system will leave your Agilent ChemStation 
data, methods, sequences, UV- libraries, customized report styles, tune 
files (for CE/MSD systems), and if present any customized macros such 
as user.mac untouched.

The remaining CHEM32 folder is left on your hard disk.

NOTE A subsequent installation of ChemStation would discover the remaining presence of this 
directory as destination and protect it from overwriting my moving it aside. This is done by 
renaming the directory (e.g. c:\Chem32) to <directory>_00x (e.g. c:\Chem32_001).
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Uninstalling the CE-MS Add-on Software

1 If the Agilent ChemStation is running close all sessions and reboot the 
computer.

2 Select Start > Settings > Control Panel > Add or Remove Programs. Select Agilent 
G2201 ChemStation CEMS Addon and press Change/Remove. The wizard starts 
and the system will ask you whether to modify, to repair, or to remove 
the CE- MS addon. Continue by selecting the  Remove option and press 
Next.

3 During uninstallation of the CE- MS Add- on your MS related Agilent 
ChemStation data, methods, sequences, UV- libraries, customized report 
styles, tune files, and if present any customized macros will not be 
removed. They will remain intact in the folders of the CE instrument.
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This chapter explains how to use the Configuration Editor to configure your 
instruments to work with the Agilent ChemStation.
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About the Agilent ChemStation Configuration Editor 

The Agilent ChemStation Configuration Editor is a program that allows 
the easy configuration of your Agilent ChemStation software. This 
includes:

• Detecting the GPIB interface in your PC

• Selecting LAN or GPIB communication

• Configuring the analytical hardware connected to the PC

• Configuring the path used for method, data, and sequence storage

• Configuring Agilent ChemStation color display

You will need to use the Configuration Editor:

• As the last step of the initial installation process for the Agilent 
ChemStation software,

• Each time a GPIB device is connected to, changed, or disconnected 
from the GPIB bus or the PC,

• Each time you change a LAN device’s IP address, and whenever adding 
or removing a LAN device from the ChemStation

After installing the Agilent ChemStation software, you are prompted to 
configure the complete analytical system.
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Configuring a ChemStation LC Instrument

In most cases, the Agilent ChemStation instrument configuration 
information has to be adapted to match the connected analytical hardware 
after the installation of the Agilent ChemStation application software. 
Most Agilent Technologies analytical hardware is modular and can be 
combined in various ways. The following instrument types are available for 
an LC configuration:

For LC 1100/1200 modules, two different sets of instruments drivers are 
available (see Table 13 on page 92 to Table 17 on page 94). The classic 
drivers have been available in the previous versions of ChemStation. 
Method and Run Control view is represented with the classical User Interface 
(see Figure 20 on page 90). The Configuration Editor needs to be 
configured with Instrument Type  Modular LC System (Classic) or Modular 3D 
LC System (Classic), respectively. 

Table 12 LC Instrument Types in the Agilent Configuration Editor

Instrument Type Supported LC Hardware Data Evaluation Capabilities LAN

LC 3D data analysis only no instrument control spectra evaluation included No

LC data analysis only no instrument control no spectra evaluation included No

Modular 3D LC system Agilent 1120/1100/1200 spectra evaluation included Yes

Modular LC system Agilent 1120/1100/1200 no spectra evaluation included Yes

Modular 3D LC system 
(classic)

Agilent 1100/1200 spectra evaluation included Yes

Modular LC system 
(classic)

Agilent 1100/1200 no spectra evaluation included Yes
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Figure 20 Method and Run Control view with classic drivers

ChemStation B.04.02 introduces support for a new set of drivers, the 
Rapid Control.NET drivers (see Figure 21 on page 91). In this case the 
Configuration Editor needs to be configured with Instrument Type Modular 
LC System or  Modular 3D LC System, respectively. 

The new drivers provide a new user interface for LC instrument control in 
the Method and Run Control view.

The new user interface offers:

• Flexible sizing of the instrument control panel to make best use of the 
available desktop space

• Show/hide functionality to reduce the display to the most essential 
information

• Graphical representation of multiple devices of the same kind (for 
example, two pumps)

• Graphical representation of all valves
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• Direct access to method parameters and all important functions for 
each module

• Status display for the individual modules and resulting overall 
instrument status

• Tool- tips reveal most important information on specific functions

• Tabular display of the sample information for the current run or 
sequence line

• Direct access to data analysis parameters

Figure 21 Method and Run Control view with RC.NET drivers

NOTE For the 1120 compact LC only the RC.Net drivers are available. When configuring a 
ChemStation for an 1120 instrument, the Configure LC System Access dialog will allow to 
add any 1100/1200 module. However, only the RID, FLD and ELSD will work together with 
an 1120 Compact LC.
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Table 13 Available Drivers for Agilent Detectors

Module/ Device Product 
Number

Classic 
Driver

RC.net 
Driver

Agilent 1100 VWD G1314A Yes Yes

Agilent 1200 VWD G1314B/D Yes Yes

Agilent 1200 VWD SL G1314C Yes Yes

Agilent 1200 VWD SL Plus G1314E Yes Yes

Agilent 1100/1200 DAD G1315A/B Yes Yes

Agilent 1100/1200 DAD SL G1315C Yes Yes

Agilent 1200 DAD G1315D Yes Yes

Agilent 1290 Infinity DAD G4211A No Yes

Agilent 1100/1200 FLD G1321A Yes Yes

Agilent 1100/1200 RID G1362A Yes Yes

Agilent 1100 MWD G1365A Yes Yes

Agilent 1100/1200 MWD G1365B Yes Yes

Agilent 1100/1200 MWD SL G1365C Yes Yes

Agilent 1200 MWD G1365D Yes Yes

Agilent 1100/1200 UIB G1390A Yes Yes

Agilent ELSD G4218A Yes No

Table 14 Available Drivers for Agilent Pumps

Module/ Device Product 
Number

Classic 
Driver

RC.net 
Driver

Agilent 1100/1200 Isocratic Pump G1310A Yes Yes

Agilent 1100/1200 Quaternary Pump G1311A Yes Yes

Agilent 1100/1200 Binary Pump G1312A Yes Yes

Agilent 1200 Binary Pump SL G1312B Yes Yes

Agilent 1200 Preparative Pump G1361A Yes No
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Agilent 1100/1200 Capillary Pump G1376A Yes No

Agilent 1100/1200 Nano Pump G2225A and 
G2226A

Yes No

Agilent 1290 Infinity High Performance Binary Pump G4220A No Yes

Table 15 Available Drivers for Agilent Sampling Systems

Module/ Device Product 
Number

Classic 
Driver

RC.net 
Driver

Agilent 1100 Autosampler G1313A Yes Yes

Agilent 1100/1200 Autosampler
(Thermostatted)

G1327A and 
G1329A/B

Yes Yes

Agilent 1100/1200 Well Plate Autosampler 
(Thermostatted)

G1367A and 
G1368A

Yes Yes

Agilent 1200 High Performance Autosampler (SL) G1367B/C Yes Yes

Agilent 1200 High Performance Autosampler SL Plus G1367D Yes Yes

Agilent 1100/1200 Microwell Plate Autosampler 
(Thermostatted)

G1377A and 
G1378A 

Yes No

Agilent 1100 Micro Autosampler G1389A Yes No

Agilent 1200 Well Plate Handler G2257A Yes No

Agilent 1200 Dual Loop Autosampler G2258A Yes No

Agilent 1100/1200 Preparative Autosampler 
(Thermostatted)

G2260A and 
G2261A

Yes No

Agilent 1290 High Performance Autosampler G4226A No Yes

CTC HTC PAL Autosampler G4270 Yes No

CTC HTS PAL Autosampler G4271 Yes No

Table 14 Available Drivers for Agilent Pumps

Module/ Device Product 
Number

Classic 
Driver

RC.net 
Driver
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Table 16 Available Drivers for other Agilent Modules

Module/ Device Product 
Number

Classic 
Driver

RC.net 
Driver

Agilent 1100 Fraction Collector G1364A Yes No

Agilent 1100/1200 Preparative Fraction Collector G1364B Yes No

Agilent 1100/1200 Analytical Fraction Collector G1364C Yes No

Agilent 1100/1200 Micro Fraction Collector G1364D Yes No

Agilent 1100/1200 Thermostatted Column 
Compartment

G1316A Yes Yes

Agilent 1200 Thermostatted Column Compartment 
SL

G1316B Yes Yes

Agilent 1290 Infinity Thermostatted Column 
Compartment

G1316C Yes1

1 no support for new 2/10 and 2/6 valves and Method Development solution

Yes

1100 Chip Cube Interface G1390A Yes No

Agilent 1200 SFC Fusion S5 G4301A No Yes1

Table 17 Available Drivers for Agilent Valves

Module/ Device Product 
Number

Classic 
Driver

RC.net 
Driver

9Pos/7Port Valve G1156A Yes Yes

2Pos/10Port Valve G1157A Yes Yes

2Pos/6 Port Valve (SL) G1158A/B Yes Yes

6Position Selection Valve G1159A Yes Yes

12Pos/13 Port Selection Valve G1160A Yes Yes

2Pos/6 Port Micro Valve G1362A Yes Yes

2Pos/10 Port Micro Valve G1363A Yes Yes

Valve Kits G4230A/B No Yes

Agilent 1290 Infinity Flexible Cube G4227A No Yes
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Configuring an Agilent 1100 or 1200 Series LC System

As listed in Table 13 on page 92 to Table 17 on page 94, for most of the 
1100/1200 modules both classic and RC.NET drivers are available. 
However, a few modules only support either of these driver set. Within 
one ChemStation instrument it is only possible to use either classic or 
RC.NET drivers.

ChemStation B.04.02 provides a configuration assistant that helps in 
selecting the driver set for your current LC instrument configuration. The 
LC Configuration Assistant starts automatically if the option  Use configuration 
assistant to configure LC system is selected when finishing the Setup Wizard.

Figure 22 Setup Wizard with option Use configuration assistant selected

The LC Configuration Assistant will guide you through the required steps:
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1 From the dropdown box, select the LC instrument that is to be 
configured. Press Next.

2 Type the IP address (or host name if name resolution is implemented 
on your network) of the 1100/1200 module with the LAN connection 
into the respective field. Before pressing Next, check that all instrument 
modules are connected and turned on.

3 The configuration assistant will detect the available modules. 
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Depending on the setup of the instrument, the assistant will provide 
information whether a Modular (3D) LC System or a Modular (3D) LC System 
(classic) can be configured. If the modules cannot be controlled by the 
same driver set the configuration will be marked as unsupported. The 
Figure below shows an example where both driver sets can be used.

You may start the Configuration Editor directly from the Configuration 
Assistant. In this case Modular (3D) LC System or  Modular (3D) LC System 
(classic) is already preselected according to the selection in the 
Configuration Assistant.

Configuring a Modular 3D LC System or Modular LC System

The following example describes how to configure an Agilent 1100/1200 
Series system using the new RC.NET drivers.

1 Start the Agilent ChemStation Configuration Editor.

2 Select the Configure > Instruments menu.

3 Select the appropriate instrument type (Modular LC System or Modular 3D 
LC System). 

4 Assign a name to your analytical instrument.

5 Specify your preferred screen window size (Normal, Icon, Full Screen).

6 Click OK.

7 In the Device Configuration dialog, select LC System Access from the list.
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8 Select Add to add the selected system access to the list of configured 
modules. 

9 Select OK to exit and return to the  Configuration Editor display.

10 Save your configuration changes by selecting File > Save.

11 Restart the Agilent ChemStation.

When you start the Agilent ChemStation for the first time, a message 
comes up asking whether Auto- Configuration should be run to 
configure the instrument. Press Yes.

12 The Instrument Configuration Dialog is displayed. Press the Auto Configuration 
button.

13 Enter the IP address (or host name) of the instrument.

The Instrument Configuration will then detect the connected modules.

Configuring a Modular 3D LC System (classic) or Modular LC System 
(classic)

The following example describes how to configure an Agilent 1100/1200 
Series system with classic drivers.

1 Start the Agilent ChemStation Configuration Editor.

NOTE The Configure LC System Access dialog is also available from the Instrument menu in the 
Method and Run-Control view, when Full Menus are displayed.
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2 Select the Configure > Instruments menu.

3 Select the appropriate instrument type (Modular LC System (classic) or 
Modular 3D LC System (classic)).

4 Assign a name to your analytical instrument.

5 Specify your preferred screen window size (Normal, Icon, Full Screen).

6 Click OK.

7 In the Device Configuration dialog, select 1100/1200 System Access from the 
list.

Figure 23 Agilent ChemStation Configuration Editor: Device Configuration Dialog

8 Select Add to add the selected system access to the list of configured 
modules. Type in the IP address (or host name if name resolution is 
implemented on your network) of the Agilent 1100/1200 module with 
the LAN connection.

9 Select OK to exit and return to the  Configuration Editor display.

10 Save your configuration changes by selecting File > Save.

11 If your IT department did not set up a BootP Service for you, you need 
to do this yourself or you need to fix the IP address with the analytical 
instrument.
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12 After modifying the configuration, you must restart the Agilent 
ChemStation. 

When you start the Agilent ChemStation for the first time, the Configure 
System Access dialog box displays the Agilent 1100/1200 modules 
detected during instrument initialization. Agilent 1100/1200 modules 
that have been recognized are listed as online (indicated by a green 
icon) along with their serial numbers. Agilent 1100/1200 modules that 
have not been detected are marked offline.

Figure 24 The Configure LC System Access dialog allows to selectively include 
detected Agilent 1100/1200 modules into the configuration.

NOTE This step is applicable for online instruments using LAN connection only. For data analysis 
only configurations, proceed with the next step. 

NOTE You can selectively take certain modules out of the software configuration, e.g. if your 
Agilent 1100/1200 system includes two Agilent 1100/1200 detectors and your next 
analysis only requires one of them. The unneeded Agilent 1100/1200 module may then stay 
turned off but remain connected. You may also re-order modules, for example if you wish to 
use one pump as the primary analytical pump and another as a make-up pump. 
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NOTE The Configure LC System Access dialog is also available from the Instrument menu in the  
Method and Run-Control view, when Full Menus are displayed.
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Configuring a ChemStation CE instrument

Configuring your Agilent G1600A CE instrument

This section describes how to set up your Agilent G1600A CE instrument 
from the Agilent ChemStation for CE Systems.

The default addresses of an Agilent CE instrument are automatically 
configured in the Agilent ChemStation. You only need to change the 
configuration if you changed the default GPIB addresses. If changes are 
required, you can access the Agilent ChemStation Configuration Editor and 
define your own parameters. The default steps are outlined below:

1 Start the Agilent ChemStation Configuration Editor.

2 Select the Configure > Instruments menu.

3 Select 3D-CE System (classic) from the list.

4 Assign a name to your analytical instrument.

5 Specify whether your instrument session should start when you start 
your Agilent ChemStation. If you select No, you may start your 
instrument at a later time by using the Utilities menu of your active 
Agilent ChemStation icon.

6 Specify your preferred screen window size (Normal, Icon, Full Screen).

7 Click OK.

8 Select Help to obtain the factory set default GPIB addresses.

9 Set the GPIB address of your Agilent CE instrument (the default 
address is 19).

Table 18 Available Drivers - Agilent CE Systems

System Product 
Number

Classic 
Driver

RC.net 
Driver

CE Series II G7100 Yes No

CE Series I G1600 Yes No
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10 Select the Diode- Array Detector from the Modules list box.

11 Set the GPIB address and select Add to add the Diode- Array Detector in 
the Selected Modules list box (default address is 17).

12 Select OK to exit and return to the  Configuration Editor display.

13 Save your configuration changes by selecting File > Save.

Configuring Your Agilent G7100 CE Instrument

This section describes how to set up your Agilent 7100 CE instrument 
from the Agilent ChemStation for CE Systems.

The default steps are outlined below:

1 Start the Agilent ChemStation Configuration Editor.

2 Select the Configure > Instruments menu.

3 Select Agilent 3D-CE 7100 System from the list.

4 Assign a name to your analytical instrument.

5 Specify your preferred screen window size (Normal, Icon, Full Screen).

6 Click OK.

7 Select the 7100 CE System Access Point and press Add

8 Select OK to exit and return to the  Configuration Editor display.

9 Save your configuration changes by selecting File > Save.

10 Restart the Agilent ChemStation.

When you start the Agilent ChemStation for the first time, a message 
comes up asking whether Auto- Configuration should be run to 
configure the instrument. Press Yes.

11 The Instrument Configuration Dialog is displayed. Press the Auto Configuration 
button.

12 Enter the IP address (or host name) of the instrument.

The Instrument Configuration will then detect the connected modules.



104 Installing LC and CE ChemStation

4 Configuring the Instruments
Configuring the Agilent ChemStation for Data Analysis Systems

Configuring the Agilent ChemStation for Data Analysis Systems

After installing the ChemStation software follow the procedure below so 
the Agilent ChemStation can identify and control your data analysis 
system.

1 If it is not already started, start the Configuration Editor: Start > Agilent 
ChemStation > Configuration Editor. At the Configuration Editor's opening 
screen, highlight the title bar of the applicable instrument and select  
Configure > Instruments....

The Select Instrument screen is displayed.
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2 Select GC or A/D Data Analysis only from the Instrument Type list provided.

3 Accept the instrument name or type a new one in the Instrument Name 
field. This field will appear in the title bar when using the Agilent 
ChemStation. 

4 Select the Initial Screen Window Size to specify how the program will open. 

5 Click OK to continue. 

6 Select File > Save.

7 Select File > Exit to return to Windows.

NOTE For “Data Analysis Only” configurations, do not change any default settings in the 
Configuration Editor other than  Instrument Name, if desired accept the instrument name. 
Instrument 1 must be set as a Gas Chromatograph (GC or A/D Data Analysis Only) and 
Instrument 2 must be set as a Liquid Chromatograph (LC Data Analysis Only).
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Configuring the Agilent ChemStation for 35900E A-D Interface 
Systems

This section describes how to configure the 35900E Analog- to- Digital 
Interface. Note that the 35900E A/D interface requires the Agilent Bootp 
Service (see “Agilent Bootp Service” on page 29).

1 If it is not already started, start the Configuration Editor: Start > Agilent 
ChemStation > Configuration Editor. At the Configuration Editor's opening 
screen, highlight the title bar of the applicable instrument and select  
Configure > Instruments....

The Select Instrument screen is displayed.

2 From the Instrument Type list provided select the 35900 ADC instrument 
you will be controlling. 

3 Accept the instrument name, or type a new one in the Instrument 
Name field. The name you type in this field will appear in the title bar 
when using the Agilent ChemStation.

4 Select the Initial Screen Window Size to specify how the program will 
open.

5 Click OK to continue. 



Installing LC and CE ChemStation 107

Configuring the Instruments 4
Configuring the Agilent ChemStation for 35900E A-D Interface Systems

6 Select the Interface Type then enter the  IP Address, or Host Name. 

7 If the Agilent ChemStation will be collecting signals, select the 
appropriate channel(s) to be used. The above example shows a 
one- channel (A) configuration. Refer to your 35900E Users Manual for 
more information. 

8 If controlling a sampler, click Change... in the  Sampler group. In the 
Sampler dialog box, select  Sampler TypeOther, and make the appropriate 
choices for the remaining items. Click OK.
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9 Define the External Start/Stop and Ready status options. To access the 
dialog box, click Change. This dialog box contains the start/stop and the 
ready status options for the 35900.

10 Select an applicable option from the available three start/stop options.

11 Select the appropriate ready status options. Select the ChemStation 
displays status of ready signal box to have the Agilent ChemStation display 
a run status signal on the screen when the instrument is ready. Select 
the ChemStation waits for ready signal box to have the Agilent ChemStation 
wait for a ready signal from the instrument before proceeding with any 
automatic processes. 

12 To return to the Device Configuration dialog box, click  OK.

13 Configure the 35900 buttons. The 35900 Buttons dialog box options 
determine whether or not the front panel buttons on the 35900 
interface can start or stop a manual run. To access the 35900 Buttons 
dialog box in the 35900 Buttons group box, click  Change.

Figure 25 35900 Buttons dialog box
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14 Select the appropriate start/stop button options for the 35900.

15 To return to the Device Configuration dialog box, click  OK.

16 Check the timed events. To define timed events for the 35900E in the 
Define Events group box, click Change.

• If you are using the 35900E in the Remote Bus mode (the default 
setting), skip this section. It does not apply to your configuration.

• If you are using the 35900E in the programmable digital I/O mode, 
you will be able to schedule 16 timed events in the Agilent 
ChemStation. First, however, you must enter the EXPRESSION you 
want to use to define each event, as described below.

• Each expression will define the “energized” state (for example, open) 
and “de- energized” state (for example, closed) of each instrument you 
will be controlling with the 35900E. Later you may schedule these 
events using the expressions you enter here in the Agilent 
ChemStation's Timed Events Table dialog box.

Figure 26 The Define Events group box

NOTE Please note that Figure 25 on page 108 shows pins 7 through 9 as user-defined and pins 2 
through 6 as default settings.
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17 Check that the information displayed in the Device Configuration dialog 
box is correct. To change any of these selections, click  Change in the 
appropriate group box.

18 Exit the Device Configuration dialog box. To return to the Configuration 
Editor main screen, click OK.

19 Save the new instrument configuration. Select File/Save. 

20 If you are going to configure more than this instrument, select another 
instrument and continue. If this is your only instrument, select File/Exit.

21 Select the Initial Screen Window Size to specify how the program will open. 

NOTE The correlation between the expression you assign and the pin number/state with which it 
is associated is saved with the instrument's definition file. The Method only stores and 
uses the EXPRESSION itself (for example, Close Valve 1). As a result, if you copy a Method 
from one Agilent ChemStation to another Agilent ChemStation, and the second Agilent 
ChemStation has a matching event EXPRESSION, but different instruments, unpredictable 
results could occur. Therefore, think of the associations you establish between an 
instrument and an event EXPRESSION as unique to your specific hardware configuration.
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Configuring Paths

The Configuration Editor lets you specify alternate path settings for your 
sequences, methods, and data files. This allows storing data files on a 
separate drive. Starting with B.02.01 it is possible to configure the path 
for methods, sequences, and data files within the Agilent ChemStation 
using Preferences as well.

This section describes how to configure different paths for your methods, 
sequences, and data files. The Agilent ChemStation default path settings 
are also listed.

1 Choose Paths from the Configure Menu.

2 Set your data file path. Default is C:\CHEM32\1\DATA\

3 Set your method path. Default isC:\CHEM32\1\METHODS\

4 Set your sequence path. Default is C:\CHEM32\1\SEQUENCE\

5 Choose OK to update the path information and return to the 
Configuration Editor display.

CAUTION Default method and sequence are used as a template for new sequences and methods.

If they are missing you cannot set up new methods and sequences.

➔ Do not delete the default method and sequence (“DEF_XX.S” and “DEF_XX.M”, 
where XX stands for the technique (LC, CE or GC). 

NOTE Before you modify the path settings using the Configuration Editor, you need to create the 
appropriate directories.

NOTE All path names have to be terminated with a backslash \.
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This chapter explains how to use the Agilent ChemStation Installation 
Qualification utility to validate the proper installation and operation 
performance of the Agilent ChemStation on your PC. It also explains how to 
begin using the Agilent ChemStation once the installation has been validated.
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Agilent ChemStation Installation Verification

After installing the Agilent ChemStation system software on your 
computer and configuring the analytical system, you may perform an 
internal validation procedure to assess the correctness and completeness 
of the installation, and to verify that the analytical system is fully 
operational. This process is called Installation Qualification (IQ). The IQ 
tool checks version codes of the Agilent ChemStation executable system 
files (*.EXE, *.DLL) and reference files.

The Agilent ChemStation Installation Qualification tool uses factory 
delivered installation reference files to verify the existence, correctness, 
and integrity of the required Agilent ChemStation system files (executable 
program files, binary register files, macro files, initialization files, help 
files, and customized report templates). 

File integrity is completed by comparing the cyclic- redundancy- check 
(CRC) checksum of the installed file with the checksum of the original file 
recorded on Agilent Technologies’ installation master. The file details of 
the installation master are delivered on so- called reference files. Modified 
or corrupted files have different checksums and are thus detected by the 
IQ Tool.

The integrity of the reference files themselves is also tracked with the help 
of checksums. If the IQ tool is supplied with a reference file that was 
modified after its generation, this will be flagged in the report (section 
invalid reference files).

As with any important upgrade to your ChemStation software, Agilent 
recommends you to perform a full Installation Qualification (IQ) and 
Operational Qualification/Performance Verification (OQ/PV) after 
installation to assess the correctness and completeness of the installation. 

Running the IQ validation procedure

The Agilent ChemStation IQT report tool is automatically installed with 
the appropriate IQT reference files.
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To perform the validation:

1 Make sure that any Agilent ChemStation software is closed before 
running the IQ Tool.

2 Select IQT Report as follows:

• Go to Start > Programs > Agilent ChemStation and select IQT Report.

• Checksum calculations for all Agilent ChemStation system files may 
take several minutes. 

3 The IQT Report Tool creates the qualification results iqtreport.hmt in 
ChemStation's main directory (usually c:\chem32). This report is 
automatically displayed on screen by the system's internet browser (e.g. 
Microsoft Internet Explorer).

On a complete and consistent installation, the installation qualification 
completes without any error messages and no files are reported missing 
or modified.

4 The report can be printed from the browser.

After closing the browser the IQT Report program will be closed.

Verification reports

The Agilent ChemStation Verification reports the following file categories:

Table 19 File categories reported by Agilent ChemStation Installation Verification

File category Explanation Required action

Identical files Required files exist and passed the 
version and integrity check.

No action required.

Missing files Files are missing that are required to 
run the Agilent ChemStation.

Use Repair functionality of the 
Agilent ChemStation Installation. 
(see “Repair of ChemStation 
Installation” on page 123)
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The shown report shows an overall status of PASS / FAIL and lists 
reference files used for the installation verification.

Example report: 

Changed files Files have been corrupted or modified. Use Repair functionality of the 
Agilent ChemStation Installation 
unless you have intentionally 
customized or updated Agilent 
ChemStation files.

Invalid reference 
file

The original reference file is corrupt or 
has been modified after creation.

Reinstall the original reference file.

Table 19 File categories reported by Agilent ChemStation Installation Verification

File category Explanation Required action
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Operation qualification / Performance verification (OQ/PV)

The OQ/PV service from Agilent will provide documented evidence that 
your new ChemStation is performing to the accepted performance 
parameters. It will verify the operation of the integrator algorithm as part 
of the chromatography verification tests. Other important areas that it will 
cover are the instrument communication and control, as well as the data 
security and access controls.

To verify the ChemStation is performing according to accepted 
performance parameters, from the Data Analysis View within your 
ChemStation application, select View > Verification > Run Test. The system 
verification test will run automatically.
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Qualifying Operation - Agilent ChemStation Verification Test

Overview

The Agilent ChemStation provides a verification test function that checks 
out the system’s software operation. Using either Agilent- supplied or 
user- generated data files and methods, the system will match calculated 
integration and quantification results with ones that have been previously 
generated and archived in an unalterable, checksum- protected, binary 
register file.

When using an Agilent 1100/1200 Series detector, or Agilent CE 
instrument with a built- in DAD (G1600A), the verification test can be 
extended to include a data acquisition check. The verification test 
generates a report that includes a list of the tested configuration, the 
verification test details like the data file and method used, and the test 
results that indicate whether the system passed a specific test step or not.

Performing the Verification Test

• After installing the Agilent ChemStation and successfully passing the 
Installation Verification, start the Agilent ChemStation.

• Select Run Test from the Verification View and run the verification test 
procedure called default.val.

• Please refer to the analytical tasks section of online help system if you 
require further information.

Acceptance Criteria

The test was passed successfully, if the verification test report indicates 
that all individual test steps were passed. This proves that internal 
components such as the Command Processor, Method Handler, the internal 
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Memory Manager for data objects, registers and tables, the Data Analysis 
modules for peak identification, peak quantification, report formatting, and 
the Agilent ChemStation print spooler are fully operational.

If the test fails, the verification test report indicates which part of the test 
did not meet the acceptance criteria. Verify you used the correct 
verification procedure. If the verification test continues to fail, we 
recommend that you reinstall the Agilent ChemStation. Do not delete your 
current system installation, as the installation procedure will copy the 
original Agilent ChemStation files on top of the existing ones.



121

Installing LC and CE ChemStation

Agilent Technologies

6
Troubleshooting

Repair of ChemStation Installation 123

Troubleshooting LAN Communication 126

Power fail reported on the Agilent ChemStation 126

Frequent Buffer Overrun in Instrument Log Book 127

Troubleshooting GPIB Interface Problems 128

GPIB Interface not found 128

“Autoadd" Button of IOCFG installs Defaults Incompatible with the 
Agilent ChemStation 129

Software Startup Problems 130

Agilent ChemStation online session does not finish startup 131

Software Startup Problems 130

Printing Problems 137

Agilent ChemStation Print Spooler hangs after an error occurred 137

Printing in Multi-Instrument configurations 137

Recovering from Printer hang-ups 138

Printing Messages 139

Computer Problems 142

Sporadic Hang-Ups 142

System Crash in an Online Session 142

Cannot create file… 142

Slow Hard-Disk access or Hard-Disk Activity LED is continuously 
flickering 143

Agilent ChemStation Performance Degrades over Time 143

LC Instrument Start-up Problems 144

System remains in a wait-state waiting for a module that has been 
taken out of the configuration 144

Data File is empty (contains no signal) 144

Devices report “Buffer Overflow” in the logbook 145



122 Installing LC and CE ChemStation

6 Troubleshooting
Qualifying Operation - Agilent ChemStation Verification Test

Using the WinDebug Utility 146

What is the WinDebug Utility? 146

WinDebug in Windows XP 146

Gathering System Information with Windows XP 149

Gathering System Information with Windows XP 149

This chapter summarizes helpful hints for troubleshooting potential problems 
you might see during the installation process.
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Repair of ChemStation Installation

If inadvertently the installation of ChemStation was damaged, e.g. by 
corrupting or removing some files, restore a backup or perform a Repair.

ChemStation's current installation will be compared with the installation 
packages on Chemstation's DVD and corrected.

Once ChemStation B.04.0x is installed, a subsequent start of 
ChemStation's installation offers to repair or remove installation.

1 Ensure that no open programs are running on your system.

2 Insert the Agilent ChemStation DVD into the DVD drive.

3 From the Start menu in the Task Bar, select Start > Run. 

4 At the command line, type 
drive:\Install\Setup.exe  (for example, E:\Install\Setup.exe), 
then click OK. 

The Setup Wizard starts.

5 Press Next

The window Repair or remove installation is offered.
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Figure 27 Repair of remove installation
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6 Select Repair to fix current installation.

Figure 28

7 After confirmation of readiness by pressing Repair check of the current 
installation starts.

After completion of the Repair process missing and corrupt files, 
shortcuts and registry entries will be fixed. Press Finish.

8 Store your DVD and any license numbers in a safe place. These will be 
required if you wish to reinstall your software or add a new instrument 
module or license.

9 Run the Installation Verification Tool to check out the upgrade of 
ChemStation. Installation Verification is discribed in “Agilent 
ChemStation Installation Verification” on page 114.

NOTE As the repair process diligently compares the current files and registry keys against the 
information in ChemStation's installation package, the Repair process takes its time - 
usually longer than the installation.
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Troubleshooting LAN Communication

Power fail reported on the Agilent ChemStation

If your Agilent ChemStation cannot connect to the analytical instrument 
configured using a LAN communication, please perform the following 
troubleshooting steps.

Verify that the IP Address is correct

1 Check the IP address and subnet mask of the Agilent 1100/1200 system 
by using the control module, if available. In the System view of the 
control module, select Configure > MIO for the module where the G1369A 
LAN card is inserted and scroll down to the IP address of the G1369A 
LAN card.

Verify that Basic Communication is possible

Use the ping command, to verify that the IP address is operational.

1 Open a command prompt window on your PC.

2 Type 
ping 10.1.1.102 where 10.1.1.102 needs to be replaced by the 
appropriate IP address or by the selected host name; and press Enter

The command ping will send a request for reply to the IP address, 
bypassing part of the Windows TCP/IP settings. A successful ping would 
look like this: Reply from 10.1.1.102: bytes=32 time<10ms TTL=128

If request timed out is displayed, the IP address can not be reached by the 
ping command.

3 If the ping request was answered successfully by the instrument, you 
need to verify that your Windows TCP/IP settings are correct for the 
selected network, especially the subnet mask and gateway settings 
should be checked.

NOTE When the MIO dialog is opened on the Agilent 1100/1200 control module, the ChemStation 
cannot communicate with the Agilent 1100/1200 system.
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Identify by host name

If you identify the Agilent 1100/1200 system by host name, ensure that 
the used host name and IP address are correctly set up in the DNS server 
or the corresponding entry in the HOSTS file exists. Try using the IP 
address in the Configuration Editor.

Verify that the G1369A LAN Card is correctly configured

To ensure that all parameters of the G1369A LAN card are correctly set, 
use the Agilent BootP Service program from the Agilent ChemStation DVD 
and disable any other means that configure the G1369A LAN card of the 
instrument. Install the BootP Service as described in section “Agilent 
Bootp Service” on page 29 and configure it for the MAC address of the 
LAN instrument. Power cycle the PC and the instrument and verify that 
the BootP Service configures the G1369A LAN card correctly. Thus you 
ensure that the parameters for the buffer handling in the G1369A LAN 
card are set for analytical instruments.

DHCP Server

Check that no DHCP servers interfere with the usage of Agilent BootP 
Service, as these servers also respond to bootp request. They also may 
send a different IP address to the instrument each time it is started.

Frequent Buffer Overrun in Instrument Log Book

Please contact your system administrator to check if the network is not 
capable of the network traffic induced due to the data acquisition of the 
instruments. This can also be caused by an incorrectly configured G1369A 
LAN card, see above.
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Troubleshooting GPIB Interface Problems 

 GPIB Interface not found

The most common problem encountered when using I/O Config is that an 
interface is not found. 

Figure 29 No GPIB Interface Was Detected on the System

For Agilent 82350 A/B GPIB interface, this is due to one of the following 
reasons:

• The interface was not installed in the PC before running I/O Config. 
Install the GPIB interface card in your system and then run I/O Config 
again.

• The interface is not firmly seated. Ensure that the board is in place and 
the boards edge connectors are fully seated.

• The GPIB interface was replaced by a different type or was installed in 
a different slot. Rerun I/O Config, remove the configured card and 
reconfigure the new one.

• The interface has already been configured by I/O Config. To solve this 
problem, you need to edit the existing configuration entry for the 
interface, instead of trying to add a new interface. In the main I/O 
Config window, click on the name of the interface configuration entry 
for the Agilent 82350 in the Configured Interfaces list box. Then click on 
the Edit button directly beneath the Configured Interfaces list box to edit 
the configuration entry for the Agilent 82350 GPIB interface.
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“Autoadd" Button of IOCFG installs Defaults Incompatible with the 
Agilent ChemStation

IOCFG has an Autoadd button. We strongly discourage you from using the 
Autoadd button because it installs default settings that are not compatible 
with the Agilent ChemStation. Please configure the IO Libraries 
interactively as described in “Validating and Starting the Agilent 
ChemStation” on page 113
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Software Startup Problems

In the following section a number of system messages are covered with their 
probable causes and suggested actions.

An online core must be purchased in order to install additional 
instrument modules

ChemStation cannot be located on your system. You must first install 
Agilent ChemStation before installing an instrument

Probable cause Suggested actions

1 Most probably, a previous version of the 
Agilent ChemStation was installed on the 
PC, but the CHEM32 directory subtree was 
deleted before starting setup. 
CHEMSTATION.INI still contains references 
to the deleted Agilent ChemStation 
installation in the [PCS] and [PCS,...] 
sections.

Delete the [PCS] sections in 
CHEMSTATION.INI.

Probable cause Suggested actions

1 ChemStation cannot be located on your 
system.

Before installing an add-on instrument control 
module, you need to install the 
Agilent ChemStation core (e.g. G2170BA).
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General Protection Fault in Module...

Agilent ChemStation online session does not finish startup

No valid license...

The Agilent ChemStation does not initialize an instrument module for 
which no valid license registration number has been entered.

Probable cause Suggested actions

1 The operating system reports a General 
Protection Fault (GPF) when it detects 
that an application has attempted write 
access to a memory location that belongs to 
another application or process. Potentially, a 
GPF is the consequence of a system 
corruption. For the diagnosis of GPFs, it is 
mandatory to record the exact error message 
and error address information in order to 
identify the part of an application program 
that caused the failure.

Windows allows tracking of GPFs with a utility 
called WinDebug (WinDbg). For more 
information on this utility, please refer to “What 
is the WinDebug Utility?” on page 146.
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Instrument not found

GPIB communication to the configured instrument or instrument module 
is not possible.

Probable cause Suggested actions

1 Before you can use the Agilent ChemStation, 
you need to enter the license registration 
number supplied with the registration packet 
delivered with your Agilent ChemStation 
installation disks. You need to enter a 
registration number for every instrument 
module that you install.

• If you installed the Agilent ChemStation 
yourself, the installation routine prompts you 
to enter the license registration number of 
the appropriate instrument module.

• If the Agilent ChemStation core software 
was preinstalled by Agilent Technologies, 
you need to install the instrument module 
software and the license registration 
number.

• If you do not specify the license registration 
number at time of installation, you need to 
start the license registration utility from the 
Agilent ChemStations group of Windows 
Program Manager. The license registration 
utility prompts you for the appropriate 
license registration numbers.

Probable cause Suggested actions

1 The instrument is turned off. Check if all modules of your instrument are 
turned on.

2 The instrument’s GPIB address does not 
match the address configured in the 
Agilent ChemStation.

3 The GPIB cable is not properly connected.

4 The GPIB board was not correctly 
configured.

please refer to “Installing and Configuring the 
Agilent GPIB Interface Board” on page 41

5 The GPIB card is incompatible with your PC.



Installing LC and CE ChemStation 133

Troubleshooting 6
Software Startup Problems

Not Ready

System Status shows Not Ready

Agilent ChemStation does not start

You receive error messages that indicate that the Agilent ChemStation 
initialization could not access specific libraries. You can close all of the 
error message boxes.

...key in section [PCS...] of CHEMSTATION.INI not valid or specified 
file does not exist

File initialization failed. The Agilent ChemStation reports an error during 
the initialization of its file structure.

Probable cause Suggested actions

1 The cause for being in a not-ready state is 
detected by the instrument.

Not-ready conditions of the Agilent liquid 
chromatographs are described in the 
documentation accompanying the respective 
instrument.

Probable cause Suggested actions

1 Windows needs this file to run. C:\
CHEM32\CORE\LAUNCHCS.EXE

Verify that the Agilent ChemStation main 
directories (default: C:\CHEM32 and C:\
CHEM32\SYS) are included in the PATH 
setting of the Environment Path variable of the 
operating system by typing 
PATH at the MS-DOS prompt. If the Agilent 
ChemStation system directories are listed in the 
PATH setting, simply close all applications and 
restart the computer.
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System Exception in dialogs.c

The Agilent ChemStation was terminated abnormally and does not restart.

Probable cause Suggested actions

1 Some path settings point to non existing 
directories.

• Verify that the Agilent ChemStation data, 
method and sequence path settings all point 
to existing directories on your PC’s hard disk. 
You can view these settings in the 
configuration editor.

• Go to the [PCS...] section in 
CHEMSTATION.INI that was specified in 
the error message (for example, [PCS,1]) 
and check the contents of the key entry.

2 There is a mismatch is in the _Exe(cution)$ 
key

Check whether the _EXEPATH$ key contains 
the correct path specification for the 
Agilent ChemStation core modules (default:  C:\
CHEM32\CORE\).

3 If the _Meth(od)File$ key is reported to be 
inconsistent,

verify that your instrument method directory (for 
example, C:\CHEM32\1\METHOD) contains 
a method directory called  def_lc.m

4 If the _Seq(uence)File$ key is reported to 
be inconsistent,

• verify that your instrument sequence 
directory (for example, C:\CHEM32\1\
SEQUENCE) contains a sequence file called  
def_lc.s.

• If one or both keys do not exist, either 
restore a backup copy, copy the 
corresponding files and directories from 
another Agilent ChemStation instrument, or 
reinstall the software.

Probable cause Suggested actions

1 This is usually caused by specific libraries of 
the application still being active in the PC’s 
memory.

Close down all applications and restart 
Windows.
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Configuration Editor no longer runs

Autostart Macro failed 

A text error message is displayed in the (red) message line of the 
Agilent ChemStation.

Probable cause Suggested actions

1 If changes are made to the 
CHEMSTATION.INI configuration file 
manually, or  CHEMSTATION.INI becomes 
corrupted, it is possible that syntax errors or 
inconsistencies are introduced into the 
Agilent ChemStation sections of this file 
which cause the Configuration Editor to fail.

• The best solution to this problem is to 
restore a backup copy of the 
CHEMSTATION.INI file which does not 
have the errors. If a backup is not available, 
the configuration sections can be removed 
manually and the configuration restored 
using the Configuration Editor. To do this, 
edit the  CHEMSTATION.INI file using the 
NOTEPAD editor and remove the sections 
that are preceded by [PCS,1], [PCS,2], 
[PCS,3], and  [PCS,4], including the section 
titles. Then, edit the lines for devices and 
instruments in the main [PCS] section to 
read: 
devices= instruments=

• Remove all of the other device statements. 
At this point, you should be able to run the 
Configuration Editor. Add the instruments 
back to the configuration and reconfigure 
the instrument devices.

• If the configuration information is still 
inconsistent and the configuration editor 
does not open, we recommend that you 
remove the [PCS] section from 
CHEMSTATION.INI and re-install the 
software.
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Probable cause Suggested actions

1 During the initialization, the 
Agilent ChemStation automatically loads 
and executes macro code from a defined set 
of macro files. A run time error caused the 
autostart macro to fail.

• If you have added your own customization 
macro code to User.Mac in the 
Agilent ChemStation core directory (default 
path: C:\CHEM32\CORE), check that all 
the macros loaded in this macro file are 
correctly specified.

• If you cannot identify or isolate the problem, 
rename User.Mac to Usr.Mac and restart 
the Agilent ChemStation. If the error 
message does not occur, you need to debug 
your customization code.

2 If the error persists, the working copy of the 
Agilent ChemStation’s configuration register 
may have been corrupted.

Rename or delete the configuration register in 
the appropriate instrument directory: The 
configuration register for instrument 1 online is 
C:\CHEM32\1\CONFIG.REG, or the 
configuration register for instrument 1 off-line is  
C:\CHEM32\1\CONF_OFF.REG



Installing LC and CE ChemStation 137

Troubleshooting 6
Printing Problems

Printing Problems

Agilent ChemStation Print Spooler hangs after an error occurred

If the Agilent ChemStation spooler does not continue after a print error 
has occurred, try initializing the Agilent ChemStation spooler by typing 
the following command on the Agilent ChemStation command line: 
_LoadServiceResetPrinting

The Agilent ChemStation spooler prompts you whether to cancel all 
pending print jobs. If you do not want to cancel the pending jobs, press 
No. If the printing error comes again, you need to save your work, close 
all applications and restart Windows and the Agilent ChemStation to 
reinitialize the operating environment.

Printing in Multi-Instrument configurations 

When printing simultaneously from multiple Agilent ChemStation 
instruments (e.g. during a sequence), resource conflicts may result in 
printing errors.

If you experience printing problems that appear to be related to a 
temporary shortage of available system resources as multiple programs 
print in parallel, you can reduce the Agilent ChemStation’s frequency to 
hand back CPU control to another application by typing the following 
command on the Agilent ChemStation command line: 
_LoadServiceChromSplYield 2000

This command specifies how often (in milliseconds) the 
Agilent ChemStation Spooler lets other application use the computer’s 
CPU. The default value is 300 ms. Increasing this number increases the 
printing speed at the expense of user interface response and should only 
be used in automated mode.

You can make this setting permanent by adding it to a macro file called 
USER.MAC in the Agilent ChemStation core directory (default: C:\CHEM32\
CORE). This executes the command automatically every time the 
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Agilent ChemStation is started. For further details on the customization 
possibilities associated with USER.MAC, please refer to the Macro 
Programming Guide which is available as online help.

Recovering from Printer hang-ups

If for some reason the communication to the printer hangs and the printer 
therefore does not finish the current printout, there are two steps that 
have to be done:

Depending on whether the printer is local at your PC or connected via a 
network:

• on a local printer do a reset on the printer panel itself, or

• on a networked printer you have to clear the network communication 
problem. This may involve checking cabling, or checking the printer 
spooler on the network host machine, or doing a reset on the printer 
panel itself.

On your PC the printer driver or the Windows Print Manager has to be 
reset. This is done by one of these alternatives:

• if a printer driver dialog box is visible that displays a Printing... message 
or similar, press the Cancel button, or

• if instead the icon of the Windows Print Manager is visible, close it. This 
will discard the current print jobs.

If the problem persists try stopping and restarting the Windows Spooler 
Service. Select Services from the Windows Control Panel, scroll down the list 
and highlight the item Spooler. Choose Stop to stop the service and restart 
it again selecting Start.

When the Agilent ChemStation spooler reports printer errors, a message 
window displays the error messages such as:Printing problem 106, with page 
file: c:\CHEM32\1\temp\~p3d0004.tmp. 

These failed print files can be printed with a command typed on the 
command line, for example 
MFPrint "c:\CHEM32\1\temp\~p3d0004.tmp"

Do not forget to delete these temporary files after you have printed them.
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Printing Messages

Printing Problem 100

Printing Problems 101, 102, 106, 108, 110, 210, 212, 300

Printing Problem 104

Probable cause Suggested actions

1 A file belonging to the current print job could 
not be found.

Check the consistency of your hard disk’s file 
structure.

Probable cause Suggested actions

1 Due to low system resources or insufficient 
disk space, a print-file could not be accessed 
either in memory or on disk.

Check free system resources using the 
Windows Task Manager. Press Ctrl + Alt + Del 
and select Task Manager. On the Performance 
Tab you will find the available physical memory. 
If free system resources are significantly below 
30 %, you should save your work, close all 
Windows applications and restart Windows.

Probable cause Suggested actions

1 The print page could not be copied in 
memory. 

Check available memory on your computer.
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Printing Problem 202

Printing Problem 204

Printing Problems 206, 208, 302

Printing Problem 214

Probable cause Suggested actions

1 The printer driver could not be initialized. • Reset the Agilent ChemStation spooler and 
check the printer driver name and version of 
your printer. Refer to the list of tested 
printers on the Agilent ChemStation 
Software DVD.

• Check available system resources.

Probable cause Suggested actions

1 A print page could not be sent to the printer 
driver.

Verify that your printer is correctly configured, 
connected, and online.

Probable cause Suggested actions

1 Printer escape sequences to initialize a new 
page or indicate the end of a print job could 
not be sent to the printer driver.

Verify that your printer is correctly configured, 
connected, and online.

Probable cause Suggested actions

1 A print job could not be removed from the 
print queue. Either the print job file does not 
exist in the temporary directory or the 
Agilent ChemStation print queue file 
(hpspl100.que) does not exist.

The print queue file and Agilent ChemStation 
temporary files must not be deleted while the 
Agilent ChemStation is running.
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Printing Problem 400, 401, 402, 403

Parts of the chromatogram missing on the report or strange fonts in 
the report

Probable cause Suggested actions

1 The Agilent ChemStation spooler could not 
be initialized properly.

If this occurs as a consequence of previous 
errors, save your work, terminate all your 
applications and restart Windows.

Probable cause Suggested actions

1 This may be caused by low system resources 
in Windows. Either too many applications 
are running or one or more applications have 
not freed up all the system resources that 
they allocated during their operation.

Check the percentage free of system resources 
in the Windows Task Manager. When free 
system resources get below 30 %, you should 
save your work, close all applications, and 
restart Windows.
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Computer Problems

Sporadic Hang-Ups 

You can use DOS commands like e.g. 
CHKDSK to verify that there are no inconsistencies in the file structure. If 
you find such inconsistencies on your PC’s hard disk, correct them. 
Information about maintenance for your computer can be found in the 
manual Configure and Maintain your Agilent ChemStation Computer 
available in PDF format on the Agilent ChemStation DVD in the manual 
section.

System Crash in an Online Session 

If your system crashes when trying to establish the GPIB communication 
to the chromatograph, there may be hardware conflict between the GPIB 
board and another device installed in your PC (for example, a specific 
graphics accelerator card, an infrared port, a soundcard). Using a different 
IO port and/or a different interrupt level for the GPIB card can eliminate 
the problem. Refer to the GPIB card configuration information in this 
handbook.

Cannot create file…

Check the available disk space on your system. Delete unnecessary files, 
for example, left- over temporary files or archive data files that you do not 
currently need to backup. Information about computer maintenance can be 
found in the manual Configure and Maintain your Agilent ChemStation 
Computer. It is available in PDF format on the Agilent ChemStation DVD 
in the manual section.
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Slow Hard-Disk access or Hard-Disk Activity LED is continuously 
flickering

Your hard disk may be fragmented. Use a defragmentation utility to 
reorganize the logical order of file clusters on your disk. If system 
performance is generally low and your hard- disk appears to be accessed 
very frequently for relatively long periods of time, the system is most 
probably low on RAM and using virtual memory (i.e. the page file) 
excessively.

• Reduce the number of concurrent programs.

• Use Computer Management options (e.g. right- click on My computer icon and 
select Manage) to access the disk management utility.

• Check whether your disk cache utility is installed and optimally 
configured.

Agilent ChemStation Performance Degrades over Time

If your environment requires continuous routine operation of the Agilent 
ChemStation over days or even weeks without restarting Windows, the 
system performance may degrade over time due to memory and resource 
leaks in the system. To overcome this problem, we recommend rebooting 
the PC on a regular basis.

Windows Service Packs are available on the Microsoft Home page. 
Following items need to be checked prior to the installation of Service 
Packs:

• the Service Pack addresses performance issues

• the Service Pack is supported with the Agilent ChemStation revision in 
use.
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LC Instrument Start-up Problems

System remains in a wait-state waiting for a module that has been 
taken out of the configuration

On systems that are frequently reconfigured, i.e. devices are added or 
removed from the current configuration, the system may remain in a 
wait- state as long as the unused devices are still connected to the APG 
remote cable. The only possible work- around is to disconnect/connect the 
remote cable when deleting/adding the external module from/to the 
current configuration.

If a second detector is not needed for certain experiments, but for 
convenience reasons is not taken out of the configuration, selecting a very 
short run- time for the unneeded detector is not recommended.

For example, when acquiring data on an FLD while the DAD is configured 
with a short stop- time, it may happen that the DAD lamp is switched off 
before the LC analysis is finished. This produces a not ready condition so 
that the next analysis does not start. Alternatively, acquiring with the 
DAD and selecting a short stop time for the FLD does not produce this 
problem as a lamp off status is a perfectly valid operational mode with 
the FLD.

Data File is empty (contains no signal)

Check the remote cabling of the detectors. A detector does not change 
into the run- status unless the start signal is transmitted over the remote 
line. Refer to the cabling diagrams in “Connecting an Agilent G1600 CE 
Instrument to the Agilent ChemStation Computer (using GPIB)” on 
page 46.
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Devices report “Buffer Overflow” in the logbook

This message usually indicates by a bad performing PC, when the data 
transfer from the instrument to the PC is not capable of handling the data 
stream. The bad performance can be caused by

• Power save features of the PC, refer to section “Advanced Power 
Management (Not Supported with Analytical Hardware)” on page 13.

• Bad network performance, refer to section “Frequent Buffer Overrun in 
Instrument Log Book” on page 127.

• Bad hard disk performance, see section “Slow Hard- Disk access or 
Hard- Disk Activity LED is continuously flickering” on page 143.

• Other programs accessing the hard disk or using the computers 
resources, like scheduled defragmentation, backup, or virus scanning.
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Using the WinDebug Utility 

What is the WinDebug Utility?

Microsoft developed certain diagnostic tools that provide detailed 
information on the internal state of Windows when General Protection Faults 
(GPF) occur on the system. WinDbg.exe is the GUI version of the debugger 
and supports both user- mode and kernel- mode debugging.

The Window debugging package comes in three versions: a 32- bit version 
for x86 binaries, a 64- bit version for Itanium binaries, and a 64- bit 
version for AMD64 binaries. For Agilent Bundle PCs, download and install 
the 32- bit version for x86 binaries.

If an application error occurs, WinDbg automatically creates a special 
dump file in the file system root directory. You can enter the details about 
the circumstances (scenario) under which the application error occurred 
and save it with the dump file. 

If General Protection Faults recur sporadically or even regularly, supply 
the dump file to your application vendor to discuss the source of the 
application error.

WinDebug in Windows XP

The Window debugging package comes in three versions: a 32- bit version 
for x86 binaries, a 64- bit version for Itanium binaries, and a 64- bit 
version for AMD64 binaries. For Agilent Bundle PCs, download and install 
the 32- bit version for x86 binaries.

Install WinDbg onto your system by running the setup. The install shield 
opens and the user has to accept the license agreement. After editing the 
user information, click Next and select Typical as installation type. If 
necessary, you may enter a installation location, click Next to start the 
installation. A new group, Debugging Tools for Windows, will be present 
within Start > Programs.
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1 WinDbg needs to be the default postmortem debugger for your 
operating system. To define WinDbg as default debugger, open cmd 
prompt by Start > Run and type 
cmd in the command line. Within the cmd prompt, execute the WinDbg 
program once with the parameter - I to create/change the appropriate 
registry entries:

e.g.: C:\Program Files\Debugging Tools for Windows\windbg.exe - I

This command will display a success or failure message after it is used. 
When WinDbg is the postmortem debugger, it will be activated 
whenever an application crashes.

2 One registry entry needs to be modified to define the kind of 
information placed into the dump file in case of a system crash. The 
modified arguments are necessary to automatically dump all the 
memory information of the failing program. The argument options can 
be obtained by entering the WinDbg help.

Open Start > Run and type
 regedit into the command line; the registry opens. Open the registry 
path \\HKEY_LOCAL_MACHINE\Software\Microsoft\Windows NT\CurrentVersion\
AeDebug.

The registry key DEBUGGER needs to be modified. By double- clicking on 
the data variable, you are allowed to edit the value data. Modify the 
value data from e.g. C:\Program Files\Debugging Tools for Windows\windbg.exe 
-p %ld -e %ld -g to C:\Program Files\Debugging Tools for Windows\windbg.exe -p %ld 
-e %ld -Q -c ".dump -ma -u c:\user.dmp;q".

The data variable values may differ for certain troubleshooting task. 
During the troubleshoot process, it might be necessary to modify the 
DEBUGGER registry entry again.

NOTE Only a system administrator can alter the postmortem settings. 

The path statements and key entries mentioned for the cmd prompt and the registry depend 
on your installation directory of WinDbg. 

NOTE The dump files intentionally contain the whole process memory and may have substantial 
size. Depending on the defined data values the dump file size will vary. Compress the dump 
file and save it to an external media or another partition in order to maintain enough space 
on your ChemStation system.
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3 In the case of a failure, a dump file named user_<date>_<time>_<pdid>.p 
is placed in the files system root directory. Enter all instrument 
configuration details, a description of the circumstances and steps 
leading to the failure and save it with the dump file. Supply all 
information to your application vendor.
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Gathering System Information with Windows XP

Gathering System Information with Windows XP

Windows XP Professional include a comprehensive information reporting 
and diagnostics program that collects and presents information on device 
driver information, network usage, and system resources such as IRQ, 
DMA and IO addresses. This utility is called “System Information” and can 
be found under the System Tools menu in the Windows Accessories menu.

Hardware conflicts will usually also be logged in the Windows Event 
Viewer, if for instance, Windows cannot start a service due to a 
misconfigured device.

For Windows XP Professional Error Reporting is implemented and enabled 
by default.

To access the settings for the reporting feature:

1 Click Start.

2 Right- click My Computer, then click Properties.

3 Click on the Advanced tab.

4 Click Error Reporting.

For more information, refer to Windows XP Professional help.
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Introduction

With ChemStation B.0x.0x release, the Agilent ChemStation made a 
progressive move towards new feature sets and structure changes. The 
revision number beginning with “B” indicates the major revision change. 
Within this chapter, a summary of the new functionality introduced for 
the revision cycle A.01.x to B.02.x is documented. For all implemented 
defect fixes, refer to the HISTORY directory on the Agilent ChemStation 
software family DVD.
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Agilent ChemStation Revision Cycle A

Agilent ChemStation A.02.0x

Data Analysis is now part of the method settings and stored in a binary 
register file.

• A.01.0x includes an older version of the Integrator module. The values 
accepted for the threshold settings have been redefined. To make the 
integration threshold settings equivalent on both platforms, the 
threshold values need to be increased by 5.

• The conventions followed by G1304/5A (HPLC2DChemStation), revision 
A.01.0x, regarding the origin handling in calibration curve calculations 
are different from the conventions followed in the later revisions. 
Revision A.01.0x offers three different modes for origin handling 
(ignore, include, force origin). The definition of Force Origin has been 
changed (see below). A new origin handling method Connect Origin has 
been added, which does exactly what  Force Origin did in A.01.0x.

Agilent ChemStation A.03.0x

Methods now include a dilution factor, in addition to the multiplier that was 
already part of revision A.02.xx methods.

Column information is restored when the new software is started for the 
first time. You have to select the currently installed column from the 
column information screen to make this information available on the reports. 
Column information is only restored for columns that have been used and 
identified for the current system. Column information from methods 
transferred from other systems is not restored.
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Agilent ChemStation A.04.0x

The Agilent ChemStation supports the enhanced integrator since revision 
A.04.01. Using the enhanced integrator is optional. Methods imported from 
a previous version of the Agilent ChemStation can continue to use the 
original integration algorithm.

The user interface allows the conversion of a method imported from a 
previous version of the Agilent ChemStation. Once a method has been 
converted to use the new enhanced integration algorithm, it cannot be 
converted back. To evaluate the enhanced integration algorithm of the 
Agilent ChemStation, we recommend that you create a backup copy of 
your original method.

The parameter sets of the original Agilent ChemStation integrator and the 
enhanced integrator are different. For example, parameters such as the 
initial threshold are values to the power of 2 of a detector specific 
constant. The enhanced integrator uses the true physical dimensions for 
integration parameter settings like slope sensitivity (Response/Time) or 
height reject (Response).

The results calculated by the two integrators may vary on real 
chromatograms due to the differences in the determination of baselines, 
shoulders, and tangent skimmed peaks.

The internal storage format of quantification data changed. Revisions 
prior to A.04.01 used single precision floating point representation for the 
internal storage of quantification data; the internal precision of the 
quantification results used 7 digits.

In revision A.04.01, the internal storage format has been changed to 
double precision floating point representation, and the internal precision 
of quantification calculations and results is now 15 digits.

The following changes have been implemented in the sequencing user 
interface and internal structure of the Agilent ChemStation.

• The sequence table has been enhanced with an Append Line button.

• The hard- coded link between sample information and specific vials has 
been removed to allow for easier cut/copy/paste operations on sequence 
lines.

• The partial sequence screen has been equipped with a print button.
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• Better integration of Sequence Summary into the sequence user interface. 
Sequence Summary Setup is now accessible through a new menu called 
Sequence Output.

• Sequence recalibration table has been eliminated from the method.

• A new sample type has been implemented to allow for quality control 
samples. Control samples can be used to verify the system’s suitability 
to run a defined set of analyses prior to running the real samples. If 
the defined system suitability criteria are not met, the sequence can be 
programmed to stop before running the real samples.

Agilent ChemStation A.05.0x

The default integration algorithm used by revision A.05.01 and higher of 
the Agilent ChemStation is the Enhanced Integrator. In previous 
revisions, the default integration algorithm used was the Standard 
Integrator. Data analysis methods could be converted to the Enhanced 
Integrator.

The user interface of the Peak Purity function available in the 
Agilent ChemStations for LC and LC/MS has been simplified, but required 
modifications to the peak purity parameters stored in the data analysis 
method. If you convert to the Enhanced Peak Purity function, the previous 
spectra settings are saved in a text file called SPCOPS.OLD in the method 
directory. Once you have converted a method to use the Enhanced Peak 
Purity function, you cannot revert back to the original method. Make a 
backup copy of your original method before converting.

Agilent ChemStation A.06.0x

The methods used for operational qualification and performance 
verification enhanced OQ/PV of the Agilent 1100 system were enhanced. The 
standard methods can be used by selecting the Standard Tests from the 
Options menu in the Verification view of the Agilent ChemStation. 
Additional software verification tests were also added that are used by the 
Agilent ChemStation A.06 OQ/PV service.
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The advanced baseline option was added to the enhanced integrator 
introduced in revision A.04.01. The tangent skim option was enhanced 
with respect to A.05.01. The default setting for both options did not 
change with respect to A.05.01.

Calibration points weights 1/Y and 1/Y2 were added to the calibration table. 
The report now also allows to generate HTM files for direct posting on a 
web server.

Agilent ChemStation A.07.0x

The sequence filldown utility allows the user to change sequence table column 
settings for specified vial ranges. Sequence table columns can be selected 
and values entered for method, sample type, updating response factors 
and time. Sample name and file name can be given a prefix and auto 
incremental number.

Agilent ChemStation A.08.0x

The ability to control the new Capillary LC system that is designed for 
increased sensitivity and for analyzing limited sample volumes was added.

The software now supports the Agilent 1100 Series well- plate 
autosampler, which is available in a standard and thermostatted version.

With revision A.08.0x, you can upgrade the Agilent Chemstation product 
to the Agilent Chemstation Plus Security Pack supporting the FDA 
requirements of CFR 21 Part 11.

Agilent ChemStation A.09.0x

The ability to control the new Agilent 1100 Series Fraction Collector and 
the Preparative Scale 1100 Autosampler, as well as the Agilent 1100 
Series Purification System for HPLC and LC/MS.

The 35900D A/D card is no longer supported (card based on the older ISA 
bus standard).
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Agilent ChemStation A.10.0x

The ability to control the new Agilent 1100 Series Fraction Collectors:

The Agilent Chemstation supports the new 40 funnel tray for high volume 
collection for high flow rates and the new tray for Eppendorf tubes (80.5 
ml, 1.5 ml and 2.0 ml).

The A.10.0x ChemStation software supports the Agilent 1100 Series 
Purification System for HPLC and LC/MS, version A.02.01.

The new XML based interface has been implemented to link the 
Agilent Chemstation to LIMS and knowledge management systems.

G1364B Preparative Scale

G1364C Analytical Scale

G1364D Micro Fraction Collector
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Agilent ChemStation Revision Cycle B

Agilent ChemStation B.01.0x

Agilent ChemStation revision B.01.xx is supporting the use of long file 
names, a higher resolution for the screen and improvements and 
enhancements for the integrator. In addition following new hardware 
modules are supported: 

• G4240A Agilent 1100 Chip Cube

• G1315C Agilent 1100 Diode Array Detector

• G1365C Agilent 1100 Multi Wavelength Array Detector (80 Hz, 8 
Signals)

USB-GPIB interface support has been added for GPIB communication based 
LC and CE systems (HP 1090, HP 1046, HP1049, CE, CE/MS).

For CE ChemStation users enhancements have been added in B.01.03 
ChemStation: 

• More flexibility defining vial usage set points within the sequence setup

• Enhanced productivity for CE ChemStation customers due to 
instrument set points modification directly in the sequence table for 
each sequence line.

Agilent ChemStation B.02.0x

Agilent ChemStation revision B.02.xx is supported with the M.01.01 GPIB 
drivers and SICL libraries for the 82350A/B card as well for the 82357 
USB- GPIB interface. The software introduces an improved user interface 
design along with a tree and table based navigation, providing fast and 
flexible data handling and the possibility to configure flexible storage 
locations for data, methods and sequences. A new packaging concept 
guarantees consistency for sequence and single sample data and makes 
use of the new data review and reprocessing capabilities in the Data 
Analysis Navigation Table.
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Agilent ChemStation B.03.0x

Agilent ChemStation revision B.03.xx has the following new features:

• printing to file type PDF.

• IO Libraries Suite 15.0 is used for GPIB systems

• Support for the new Agilent OpenLAB Intelligence reporter G4635AA

For LC Systems the following new modules are supported:

• G4218A Agilent 1200 Evaporative Light Scattering Detector (ELSD)

• G1314D Agilent 1200 Variable Wavelength Detector

• G1314E Agilent 1200 Variable Wavelength Detector SL Plus

• G1367D Agilent 1200 High Performance Autosampler SL Plus
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Agilent ChemStation Revision Code Convention 

Revision numbers are created according to the scheme outlined below:

P.RR.xxY

P- Denotes the identifier of the series of a product. This letter is identical to 
suffix character in the product number.

Example:

The B in the product number G2170BA defines that revision code starts 
with a series identifier B. It is current Agilent Technologies policy not to 
change the series identifier unless the software changes in purpose or 
function. The A in the product number stands for the American English 
version.

RR- Represents the major revision number. Changes in this code typically 
include significant software enhancements that may require complete 
revalidation of the system for customers operating in regulated 
environments. These revisions may also include defect fixes and 
documentation changes.

xx- Represents the minor revision number. These revisions correct software 
defects and are generally isolated in nature. They may contain minor 
enhancements or new features, but the functionality has not changed. A 
minor revision change usually does not require revalidation of the system 
for customers operating in regulated environments. These revisions only 
include defect fixes that do not affect the accuracy of the handbooks.

Y- Represents the localization code. This character states the localized 
version of Software. For example, the B.01.01C is representing the Chinese 
version of the Agilent ChemStation. Note, this additional code is only 
present for separately localized versions, for standard American English 
version no Y suffix will be present. 
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Agilent Technologies Customer Contact Center

Support services resolves problems and maximizes performance

The Agilent network of Customer Contact Centers provides access to 
support professionals who help you resolve operational difficulties, and 
offer assistance and advice on running Agilent analytical software. 
Traditionally, this support is given over the telephone but it may also be 
extended to remote support via modem when you authorize us to do so. 

First year software support is available and may be extended by two years 
at very competitive rates. This support provides entitlement to telephone 
assistance, software revision upgrades when they are released, and regular 
delivery of Software Status Bulletins containing important information on 
known problems and available work- around solutions for your Agilent 
analytical software. For more information on how to register for these 
services, please contact your local Analytical Support Representative.

Your local Analytical Support Representative will also provide information 
on available consulting, customization, development, and training services 
on Agilent analytical software products.

Agilent support and update services are subject to your local country’s 
prices, terms, and conditions ruling at the time you place your order.

Calling the Agilent Technologies LSCA Customer Contact Center 

When you call the Agilent Technologies Customer Contact Center, please 
be at your computer and have the product documentation at hand.

We recommend that the following information be readily available:

• The registration packet label with the product number, revision code, 
and license registration number of your analytical software

• The exact wording of any error messages that the system produced
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• A list of the instrument modules including firmware revisions that are 
connected to the PC. You may use the Serial number information from 
the Agilent ChemStation (in Full Menu view only) Method/Run Control > 
Instrument > Serial numbers and Columns to generate this list.

• A full printout from Windows System Information

• A description of the scenario that leads to the failure
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Contents of the Agilent ChemStation DVD 

Starting with the ChemStation Release B.04.01, the Agilent ChemStation 
comes along with one DVD. The DVD contains the following items 

• All installables,

• Firmware and communication tools, 

• ChemStation manuals, 

• Support documentation,

• Software accessories e.g. user contributed library (UCL).

Agilent ChemStation Modules

The DVD contains the executable files for all modules that belong to the 
Agilent ChemStation product family. In order to install a module, you have 
to supply a license registration number valid for the module. Those 
numbers “unlock” the protected DVD. They are included with the original 
product and are your proof of license.

There is a shortcut to the main setup program setup.exe for initial 
installation of the Agilent ChemStation modules located in the root 
directory on the Agilent ChemStation DVD. Afterwards additional modules 
may be added by Add Instrument from the Agilent ChemStation program 
group.

Installation Verification Tool for Installation Qualification

The Agilent ChemStation comes with an utility that allows to qualify and 
document the completeness and integrity of a new installation. The IQT 
Report Tool is installed automatically with the Agilent ChemStation.
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I/O Libraries for the Agilent 82350 A/B GPIB Interface and the 
82357A USB-GPIB Interface 

The Agilent ChemStation DVD contains the version of the I/O Libraries 
that has been successfully tested with B.04.xx of the Agilent ChemStation. 
The I/O Libraries must be installed separately to be used with the GPIB 
cards as well for the USB- GPIB device. The installation is described in the 
separate guide Agilent IO Libraries Suite 15.0 or higher Installation and 
Configuration Instructions.

BootP Service

The Agilent ChemStation DVD contains a BootP Service setup in the 
directory BOOTP that can be used to supply the analytical instruments 
that are connected to a LAN with an IP address and configuration 
settings. This BootP Service is easy to configure for the use of analytical 
instruments using a LAN connection. Refer to section “Agilent Bootp 
Service” on page 29 for more information about the BootP Service.

Agilent ChemStation Software Status Bulletin (SSB)

The Software Status Bulletin is a document reflecting the results of 
Agilent Technologies defect logging, tracking, and repair methodology by 
publishing the current status of Agilent ChemStation application software 
products (known defects, available fixes, additional information).

The SSB is located in the SUPPORT\SSB directory of the 
Agilent ChemStation DVD.

Agilent ChemStation Revision History 

The revision history is targeted towards users who may have to consider 
revalidating their analytical data system after upgrading to a new revision 
of the application software. The history files are located in the SUPPORT\
HISTORY directory of the Agilent ChemStation DVD.
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Agilent ChemStation Product Documentation

The Agilent ChemStation product documentation consists of printed and 
online (PDF) handbooks with reference information and online 
documentation for task- orientated topics. PDF versions of all manuals are 
also located on the ChemStation DVD in the directory MANUALS, together 
with Adobe Acrobat reader (required to read PDF files).

For more details on the Agilent ChemStation product documentation 
please refer to “Learning Products” on page 168.

I Upgraded from a Previous Version - How Do I Know What Has 
Changed Since Then?

When starting the Agilent ChemStation for the first time, you can select to 
go to the What’s new section of the help. Later on you can always go to 
the table of content of the help file and select new features to find out 
what features have been added to the Agilent ChemStation.

For upgrades from Agilent ChemStation Rev. A.xx.xx to Rev. B.04.0x a 
separate guide called Upgrade Preparation Guide for Agilent 
ChemStation Rev. B.04.02 is available as printed manual and as PDF 
document within the manual section of the Agilent ChemStation DVD.

A list of all defect fixes since the last revision is located in the directory 
support\history.
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Learning Products 

A wide range of learning products are supplied with your Agilent 
ChemStation software, the PC, and the instrument(s). This includes 
printed and online manuals, online help and related setup and 
maintenance information. For first time users a “Tutorial” is available in 
the online help of the Agilent ChemStation. It documents in detail the 
first steps necessary to control and run an Agilent 1100/1200 LC System. 
In addition ChemStation comes with an extensive Diagnostic Software.

The Agilent ChemStation handbooks do not cover details on analytical 
hardware (other than those required for installation and configuration for 
operation with the Agilent ChemStation).

Documents 

The Agilent ChemStation product documentation consists of printed and 
online (PDF) handbooks with reference information and online 
documentation for task- orientated topics. PDF versions of all manuals are 
located on the ChemStation DVD in the directory MANUALS, together with 
Adobe Acrobat reader (required to read PDF files).

• This and the Agilent ChemStation for GC Systems, Data Analysis, and 
35900E A/D Converter installing handbook describe how to prepare 
your Agilent ChemStation for operation by installing the necessary 
hardware and software.

• All reference information, i.e. explanation of general concepts, 
algorithms, and formulae is contained in the “Understanding” 
handbooks. The Understanding Your ChemStation handbooks generally 
do not provide task- orientated information (e.g. “How to set up a 
sequence”).

• The XML interface is fully documented in the Agilent ChemStation XML 
Connectivity Guide, available as a PDF document in the manuals folder 
on your Agilent ChemStation DVD.

• For the ECM Integration with ChemStation, please refer to the ECM 
Interface Guide available on the Agilent ChemStation DVD as well.
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• Information regarding the LC used standard LAN communication card 
(G1369A LAN card) is available in the PDF document Agilent G1369A 
LAN Interface Manual.

• The Macro Programming Guide is available electronically through the 
Agilent ChemStation help system.

Where Can I Find the Description of Agilent ChemStation Commands and 
Data Structures?

An online Macro Programming Guide and Commands Reference are available for 
advanced users and Agilent ChemStation application developers. The 
Commands reference information can be accessed from the 
Agilent ChemStation help menu: Help > Commands, and is structured into 
command categories and the command descriptions with syntax, 
parameters, and return values along with a discussion and frequent 
examples.

What Is Task-Oriented Information and Where Is It? 

Task- oriented information describes how to perform a certain task and is 
therefore very context- specific. The context- specific “How- To” information 
is contained in the Agilent ChemStation help system. The help system 
always can be evoked by pressing the F1 function key, the Agilent 
ChemStation Help menu, or the Help button available in Agilent 
ChemStation dialog boxes.

Access the Help > Help Topics menu and click the LC Tasks or GC Tasks index. 
Select the analytical task that you need instructions for.

For more details on the online- help see section “Agilent ChemStation Help 
System” on page 169.

Agilent ChemStation Help System

The Agilent ChemStation help system provides an extensive material 
database of information under the following menu items:

• ChemStation Tutorial contains a tour of the software and walkthroughs 
of common tasks to help you learn the fundamentals of the system.
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• How to work with your ChemStation contains a set of instructions for 
your Agilent ChemStation. You can learn how to perform tasks for the 
method and run control, data analysis, report layout, verification 
(OQ/PV), and diagnosis view features.

• User Interface Reference contains a detailed description of all items in 
the menus, toolbars, and dialog boxes of the Agilent ChemStation 
software. The descriptions are sorted by the different Agilent 
ChemStation views.

• Concepts of ChemStation contains information on selected concepts of 
the Agilent ChemStation software, including integration, calibration, 
calibrated report types, spectra processing, and peak parameters.

• Error Messages lists all instrument error messages that may occur, with 
possible causes and corrective actions. 

• Troubleshooting provides information that can help solve common 
problems with your Agilent ChemStation.

• Commands contains an extensive list of commands and the name, 
group, syntax, parameters, discussion, return value, and examples 
(where possible) of different tasks in the Agilent ChemStation software.

• Macros contains the Macro Programming Guide, which explains the 
purpose and basic structure of a macro and how macros are written 
using command strings. Macros allow you to customize the Agilent 
ChemStation software to best fit your needs.

More information

For more information, visit the Agilent web site at 
http://www.agilent.com/chem.

Agilent Lab Advisor

Agilent Lab Advisor is an application independent software that helps you 
manage your lab for high quality chromatographic results. The innovative 
solution can monitor a single Agilent GC or LC or all the Agilent GCs and 
LCs in your lab — in real time. It automatically tracks usage of supplies, 
monitors chromatographic quality and notifies you of maintenance needs 
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before a problem occurs. By keeping track of injections, hours of operation 
and other user- specified parameters, the software “knows” when it is time 
to replace consumables or perform basic upkeep tasks. 

Agilent Lab Advisor software provides full diagnostic capabilities with an 
extended list of tests and calibrations procedures and automates basic 
diagnostic routines that help verify proper instrument performance.

Following functions are available in Agilent Lab Advisor software:

• Lab at a Glance – Displays operational status of monitored instruments 
and associated advisories, errors, warnings, and messages

• Lab Monitor Management – Provides options to manage users and 
instruments

• Instrument Documentation – Provides instant access to all user and service 
documentation for the selected instrument

• System Information – Displays additional information about the monitored 
instruments

• Tests – Provides full diagnostic procedures for all connected instruments 

• Calibrations – Provides necessary calibration procedures for connected 
instruments

• Early Maintenance Feedback  -  Displays instant visual indication of 
preventive maintenance needs, so you can be sure you are getting the 
maximum performance from all your instruments

• Status Report – Generates a report that includes instrument configuration 
information error history, EMF resources monitored and diagnostic test 
results

• Calendar -  Plan tasks and organize instrument service for the monitored 
instruments

• Log and results – Provides the test and calibration results done on the 
connected

• Tools – Provides additional maintenance features
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Related setup and maintenance information 

• A README file contains information on items such as added new 
features, known work- arounds, and corrections that could not be 
included in this manual at the time of printing. To access the 
readme.txt file, select Start > Programs > Agilent ChemStation > readme.txt.

• An automatically updated Logbook contains any error condition 
discovered during operation and corrective actions (if required). To 
access, choose Logbook from the View menu, then double- click the 
entries. The most recent entries are at the top of the list.

User-contributed library 

The contents of this library are intended to help users develop and 
customize the installations for their specific needs to get the most out of 
their investment.

The content of the library is derived from both Agilent internal and 
user- contributed sources. Each contribution is checked for functionality 
but does not necessarily go through the same level of formal testing 
procedures as the actual product. Therefore, Agilent Technologies does not 
guarantee the correctness of the contributions.

The User- Contributed Library is located on ChemStation DVD in the 
directory UCL. It comprises utilities and macros. Each contribution is 
delivered with a specific README.TXT file that can be viewed using any 
text editor.
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In This Book

Use this handbook when you install the 
Agilent ChemStation for the first time or 
when you make changes to an installed 
system. This handbook describes how to 
install the initial software, how to add 
further instrument modules, how to configure 
your analytical system, and how to verify 
that the installation and configuration are 
complete and operational.

This handbook lists the PC hardware and 
software requirements that need to be met in 
order to install and operate the Agilent 
ChemStation successfully and explains PC 
configuration details that you will find useful 
when upgrading your computer, optimizing 
your system, or when trying to solve a 
problem related to installation. You may skip 
these chapters if your Agilent ChemStation 
was fully installed by Agilent Technologies.
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